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Programming in JScript
JScript functionality in Intellect

The JScript programming language is used in Intellect to implement additional user functions not included in the basic Intellect functionality.

JScript is a de-facto standard for developing and running user scripts. Intellect supports the version of JScript based on ActiveX technology by Microsoft. The general description of the
JScript object model is given in the Microsoft documentation (for example, MSDN).

The JScript scripts in Intellect are executed using the standard ActiveX modules included in the Windows operating system. So, any objects from the ActiveX-based JScript can be used
in developing the scripts for Intellect.

A set of specialized JScript objects is provided in Intellect for handling Intellect system objects, and for sending and receiving system events and actions.
Description of the JScript object model in Intellect

The Core object and its built-in methods

The Core object

The Core object is a global static object providing the methods for monitoring and controlling the Intellect system objects. Core methods allow receiving information about the existing
objects, generating reactions for them and changing their states. Core methods can pause script execution, script debugging, creating and calling global variables.

The Core object is not a prototype, thus no other objects can be created on its base (it cannot be used as a template). All Core methods are static. Thus, Core methods are called
directly from the script with no need for a Core prefix.

The SetObjectParam method

The SetObjectParam method sets the values of object parameters.

Method call syntax

function SetObjectParanmobjtype: String, id: String, param: String, value : String)

Method arguments:

=

objtype - required argument. The type of the object whose parameters are to be set. It takes the following values: Type - String, range - existing object types.

2. id - required argument. Identification number of the object of the type set in the objtype parameter. It takes the following values: Type - String, range - existing object
identification numbers of the specified type.

3. param - required argument. The parameter of the object. It takes the following values: Type - String, range - available parameters of the object.

4. value - required argument. The value to be set for the parameter specified in the param argument. It takes the following values: Type - String, range - depends on the

parameter.

Usage examples



Example. When Macro 1 starts, check if Cameras 1 to 4 are set to broadcast color video. If a camera is set for black-and-white video broadcast, then switch it to the color mode
(setting the true (*1”) value to the “Color” parameter — (“color”)).

if (Event. SourceType == "MACRO' && Event. Sourceld == "1" && Event.Action == "RUN")
{
var i;
for(i=1; i<=4; i=i+l)
{
if (GetQbjectParan("CAM', i , "color") == "0")
{
Set hj ect Param("CAM', i, "color", "1");
}
}
}
Note

If the object is active when the script is started (i.e. the setting panel of this object is open), then object parameters can not be changed by the SetObjectParam method. For
instance, if the setting panel for the Camera 1 object is open and the aforecited script is started, the operation mode of Camera 1 will not be changed for the color one.

The SetObjectState method

The SetObjectState method changes the state of objects.

Method call syntax

function SetObjectState(objtype : String, id : String, state : String)

Method arguments:

1. objtype - Required argument. The type of the object whose state is to be changed. It takes the following values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype parameter. It takes the following values: Type - String, range - existing object
identification numbers of the specified type.

3. state - Required argument. The state to switch the object to. It takes the following values: Type - String, range — available states of the object.

Usage examples



Example. Check if Camera 1 is armed every hour. If Camera 1 is disarmed, arm it.

Note

The Timer object with identification number 1 should be created beforehand. Set the Minutes parameter of the Timer object to 30.The timer would go off every hour at half
past the hour - 09:30, 10:30, 11:30, etc.

if (Event. SourceType == "TI MER' && Event. Sourceld == "1" && Event. Action == "TRI GGER")

{
if (GetObjectState("CAM, "1") == "Dl SARVED")

{
Set Obj ect State("CAM', "1", "ARMVED');

The DebuglLogString method
The DebuglLogString method outputs the user messages into the debug windows of the Editor-Debugger utility.

Method call syntax

function DebuglLogString(output : String)
Method arguments:

output - Required argument. The text message to be displayed in the debug window of the Editor-Debugger utility. It takes the following values: Type - String.

Usage examples

Problem. Output to the debugger window all microphone events registered by the system.

if (Event. SourceType == "COLXA LI NE")

{
var nmegstr = Event.MsgToString();

DebuglLogStri ng("Event fromthe mcrophone " + nsgstr);



The Base64Decode method
The Base64Decode method is used for decoding the lines that are coded by Base64 scheme.

Method call syntax

function Base64Decode(data_in: String, WdeChar: Bool ean)
Method arguments:

1. data_in - required argument. Set a line that should be decoded in Base64;
2. WideChar - required argument. Determines coding type. Can take 0 or 1 values. If coding type is Unicode, argument value is 1, otherwise 0.

Usage examples

Decode the line that is set in Base64 by starting macro N21. Output the decoding result into the debug windows of the Editor-Debugger utility. (Result is « Intellect JAVA SCRIPT» line).

. if (Event.SourceType == "MACRO' &% Event.Sourceld == "1" &% Event.Action == "RUN') 5
{ |
var str = Base64Decode(" SWo0ZWsZWNOI EpTY3JpcHQ= ", 0);
DebugLogSt ri ng(str);
} i
The Sleep method
The Sleep method pauses the execution of the script for a specified period of time.
Method call syntax

function Sleep(mlliseconds : int)
Method arguments:
milliseconds - Required argument. The length of time that the script will be inactive for. Set in milliseconds. It takes the following values: Type - int.

Usage examples

Problem 1. When Macro 1 starts, play the following audio files one by one: cam_alarm_1.wav, cam_alarm_2.wav, cam_alarm_3.wav from the ...\Intellect\Wav\ folder. Set a 5 seconds
(5000 milliseconds) delay before starting each subsequent file.



i f (Event. SourceType == "MACRO' && Event. Sourceld == "1" && Event.Action == "RUN')
{

var i;
for(i=1; i<=3; i=i+l)
{
DoReact Str (" PLAYER', "1", "PLAY WAV', " file<\camalarm" + i + ".wav>");

Sl eep(5000) ;

Problem 2. When macro N22 starts, timer N21, that triggers every 10 seconds in a minute after macro N22 starting, starts.

Note

To start this script create the Timer object with ID=1 beforehand. Leave object parameters set by default (Any). The Timer 1 object can be disabled

L (Event. Sour ceType == "MACRO' && Event. Sourceld == "2" && Event.Action == "RUN")
{ |
for(i=0; i<=5; i=i+l) !
{ i
mReaCt St r ( n TI WRI , n 1Il , n DI SABLEII , n II) ; i
Sl eep(10000) ;
DoReact Str("TI MER', "1", "ENABLE", ""); E
NotifyEventStr("TIMER","1", "TRI GGER', ""); ;
} i
DoReact Str("TIMER', " 1", "DI SABLE", ""); 5
} 5

The Itv_var method
The Itv_var method sets and returns the values of global variables.

Method call syntax
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function |Itv_var (globalvar : String) : String

Method arguments:

globalvar - Required argument. The name of the global variable. It takes the following values: Type - String, satisfying the rules for the names of the string parameters in the
Windows registry.

Global variables are stored in the Windows registry to maintain their values after Windows restart. All global variables are stored in the registry branch HKEY_USERS\S-1-5-21-
..\Software\ITVScript\ITVSCRIPT and HKEY_CURRENT_USER\Software\ITVScript\ ITVSCRIPT. To access a global variable directly from the registry, search the registry for it by its
name.

Usage examples

Problem. When Macro 1 starts, save the value of the bright parameter of Camera 10 to the cam10bright global variable. When Macro 2 starts, set the bright parameter of Cameras 1 to
4 to the value of the cam10bright global variable.

if (Event. SourceType == "MACRO' && Event.Action == "RUN'")

{
i f(Event. Sourceld == "1")

{

Itv_var("camlObright") = Get Qbj ect Paran("CAM', "10", "bright");
}
if (Event.Sourceld == "2")

{
var camlObright = Itv_var("canlObright");

for(i=1;, i<=4; i=i+l)
{
Set bj ect Param("CAM', i, "bright", camlObright);

The Int_var method

The Int_var method sets and returns values of global variables of integer type.

Attention!



The Int_var method uses the same storage as the Itv_var method, but modify the type of variable to the integer type.

Method call syntax:

function Int_var (globalvar : String) : int

..........................................................................................................................................................................................................................................................................

Method arguments:
1. globalvar - required argument. The name of the global variable. It takes the following values: type — String, satisfying the rules for the names of the string parameters in the

Windows registry.

Note.
Global variables are stored in the system registry to maintain their values after Windows restart. All global variables are stored in the registry branch HKEY_USERS\S-1-5-21-
.. \Software\ITVScript\ITVSCRIPT and HKEY_CURRENT_USER\Software\ITVScript\ ITVSCRIPT. To access a global variable directly from the registry, search the registry for it

by the same name.
Usage examples. To check the method operation in the following test example the value 1 sets to the "2" global variable and then increases per 1 and displays on the script debug

window.
g

i f(Event. Action =="RUN'")

{ |
Int_var(2) = 1,
Int_var("2") ++;
DebuglLogString(Int_var("2").toString()); ;

} |

The GetObjectParentType method
The GetObjectParentType method returns the type of the parent object of the current object according to the object hierarchy.
Method call syntax
. function Get oj ect Parent Type (objtype : String) : String i

Method arguments:

11
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objtype - Required argument. The type of the object whose parent’s type should be returned. It takes the following values: Type - String, range - existing object types.
The Main object is the highest level object in the hierarchy. It is the parent for all objects of the Computer, Screen, and other types.
Usage examples

Problem. When Macro 1 starts, display in the debugger window the names of four object types of higher hierarchical order starting from the detection zone.

i f (Event. SourceType == "MACRO' && Event. Sourceld == "1" && Event.Action == "RUN')

{
var objtype = "CAM ZONE";
DebuglLogSt ri ng( obj type);
for(var i = 1; i<=4; i=i+l)
{
obj type = Get Obj ect Parent Type(objtype);
DebuglLogSt ri ng( obj type) ;

The GetIPAddress method

The GetIPAddress method returns the IP-address of the Intellect kernel according to current video surveillance system architecture.

Method call syntax

function GetlPAddress (dst : String, src : String) : String

Method arguments:

1. dst - Required argument. The name of the remote computer where the Intellect kernel is installed. The value of dst should correspond to one of the names of the computers
registered during setup of the video surveillance system. It takes the following values: Type - String, meeting the requirements for network computer names; range -
computer names existing in the system.

2. src - Required argument. The name of the local computer where the script executes. The value of src should match the name of the local computer as it is registered in
Intellect. It takes the following values: Type - String; meeting the requirements for network computer names.

The information about all connections of the local computer (kernel) to other remote computers (kernels) registered during the setup of the distributed architecture, is displayed in the
Architecture tab of the System Settings window.

Usage examples



Problem. Upon a camera alarm, determine the name of the server this camera is connected to, and output the IP-address of the connection between this server and the local computer
where the script executes, to the debugger window.

if (Event.SourceType == "CAM' && Event.Action == "MD_START") i
{
var canmid = Event. Sourcel d;
var conpnanme = Cet Obj ectParent!|d("CAM', cam d, "COWPUTER');
var ip = Getl PAddress("Ws1","W51"); \\if the script is run on the conputer where kernel of Intellect
sof tware has been installed
DebuglLogStri ng("1 P-address of the alarnmed canera conputer" + ip);
}
The GetObjectName method
The GetObjectName method returns the name of the object that it was given upon creation.
Method call syntax

function GCetObjectNane(objtype : String, id : String) : String

Method arguments:

1. objtype - Required argument. The type of the object whose name is to be returned. It takes the following values: Type - String, range - existing object types.
2. id - Required argument. Identification number of the object of the type set in the objtype parameter. It takes the following values: Type - String, range - existing object
identification numbers of the specified type.

Usage examples

Problem. In case of alarm in any sensor, open the information window with the following text - "Alarm in the <alarmed sensor name> sensor connected to the <server name which the
sensor is connected to> server”.

Note

Create the information dialog window beforehand using the Arpedit.exe utility and save it as test.dlg in the <Intellect>\Program folder.

i f (Event.SourceType == "GRAY" && Event.Action == "ALARM')
{

13
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var grayid = Event. Sourcel d;

var grayname = Cet Obj ect Nane(" GRAY", grayid);

var conpname = CGet Qbj ect Parent | d("GRAY", grayid, "COWUTER');

DoReact Str ("Dl ALOG', "test", "CLOSE_ALL","");

DoReact Str ("Dl ALOG', "test", "RUN',"Alarmin the '" + graynane + "' sensor connected to the '" + conpnane +
server.");

}
The GetObjectState method
The GetObjectState method returns the state of the object at the moment of method call.
Method call syntax

function GCetObjectState(objtype : String, id : String) : String
Method arguments:

1. objtype - Required argument. The type of the object whose state is to be returned. It takes the following values: Type - String, range - existing object types.
2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification
numbers of the objects of the specified type.

Usage examples

Problem. When Relay 1 activates (for example, on pressing the button connected to Relay 1), arm Sensor 1. The next time Relay 1 activates, disarm Sensor 1.

5 if (Event. SourceType == "GRELE" && Event. Sourceld == "1" && Event.Action == "ON') 5
{ f
i f (Get Qbj ect St at e(" GRAY", "1")=="DI SARM') i

{ |
Set Qbj ect St at e( " GRAY", "1", "ARM'); 5

} |

el se f

{ |
Set (bj ect Stat e(" GRAY", "1", "Dl SARM'); i

} |

} i
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The GetObjectParam method

The GetObjectParam method returns the value of the specified parameter of the object at the moment of method call.

Method call syntax

function GetObjectParanm(objtype : String, id: String, param: String) : String

Method arguments:

[y

. objtype - Required argument. The type of the object whose parameter’s value is to be returned. It takes the following values: Type - String, range - existing object types.
2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification
numbers of the objects of the specified type.

3. param - Required argument. The name of the parameter whose value is to be returned. It takes the following values: Type - String, range — available parameters of the
object.

Usage examples

See the example for the SetObjectParam method.

The GetObjectParentld method

The GetObjectParentIld method returns the identification number of the parent of the specified object.

Method call syntax

function GCetObjectParentld(objtype : String, id: String, parent : String) : String

Method arguments:

1. objtype - Required argument. The type of the object whose parent’s identification number should be returned. It takes the following values: Type - String, range - existing
object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification
numbers of the objects of the specified type.

3. parent - Required argument. The type of the object which is the parent of the object type specified by the objtype argument. It takes the following values: Type - String,
range - existing object types.

Usage examples

Problem. If a camera turns off or stops transmitting a video signal, send an e-mail message with the following subject: "Warning! Camera turned off" and, in the message body, the
number of the camera and of the server it is connected to.
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Note

The Short Messages Service is supposed to be installed and working properly

if (Event. SourceType == "CAM' && Event. Action == "DETACH'")
{

var camid = Event. Sourcel d;
var parent_conp_id = GetQbj ectParentld("CAM', cam.id, "COWUTER'");
DoReact St r (" MAI L_MESSAGE", "1", "SETUP", "fromc***@rai | . ru>, to<***@mi | . ru>, body<Canera di sabling "+cam.i d+" on

the Server” pare t_CO 'p_i d+" >, par ent i d<1>, Subj ect<Attention! Canera disabli ng>, IIaIre<VEssage 1>, Obj nanme<Message
1>") ; g
DoReact Str ( "MAI L_MESSAGE", "1", "SEND', " ") ;

The DoReactStr method

The DoReactStr method generates the response actions for the objects. It sends the action to the specified object. The action is transferred directly to the kernel where the object
belongs, and not to the whole system. The action is specified as a group of String arguments.

Method call syntax

function DoReactStr(objtype : String, id: String, action : String, paranxkvalue> [, paranxkvalue>] : String)

Method arguments:

1. objtype - Required argument. The type of the object that the action should be generated for. It takes the following values: Type - String, range - existing object types.

2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification
numbers of the objects of the specified type.

3. action - Required argument. The action to be generated. It takes the following values: Type - String, range — available actions for the objects of the specified type.
4. param<value> - Required argument. Several arguments of this type can be specified. The parameters of the action.

One parameter has the following syntax:
"param<value>", where

param - name of the parameter;

value - value of the parameter.

Several parameters have the following syntax:



"paraml<valuel>,param2<value2>.."

Elements of the list are separated by commas with no white space. If no parameters need to be specified, an empty string is used:

5 DoReact Str("CAM', "1" ,"REC',""); i
The param argument can take the following values: Type - String, range - available parameters of the specified action. The value argument can take the following values: Type -
String, range - depends on the parameter.

For all reactions it is possible to specify delay of reaction performing using delay<> parameter. Delay is specified in seconds.
Note
Two types of system messages are available in the Intellect system: events and actions.
The events usually contain some information and are used as notifications sent to all Intellect kernels connected to each other during the system setup.
The actions are the control commands sent to specific objects. An action is transmitted only to the kernel where the related object belongs, and not to the whole system.
The DoReactStr and DoReact methods are used to generate actions. The NotifyEventStr and NotifyEvent methods are used to generate events.
Usage examples
Problem. When an alarm is received from a camera, switch Monitor 1 to single window mode and show the video from the alarmed camera in this window.
i if (Event. SourceType == "CAM' && Event.Action == "MD_START")
{
var canmid = Event. Sourceld;
DoReact Str("MONI TOR', "1", "ACTI VATE_CAM', "canx"+ cam d +">");
DoReact Str("MONI TOR', "1", "KEY_PRESSED', " key<SCREEN. 1>") ;
}
Problem. When alarm by some camera is completed the record is to be continued for 5 second and after this time the record will be stopped (analogue of Post-record mode).

if (Event.SourceType == "CAM' & & Event.Action == "ND_STOP")
{

var cam d = Event. Sour cel d;

DoReact Str (" CAM', cam d, "REC STOP", "del ay<56>");

17
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if (Event. SourceType == "MACRO' && Event.Action == "RUN' && Event. Sourceld == "1")

{
DoReact Str (" MONI TOR', " 10", " CONTROL_TELEMETRY", " camx4>, on<1>");
}
if (Event.SourceType == "MACRO' && Event.Action == "RUN' && Event. Sourceld == "2")
{
DoReact Str (" MONI TOR', " 10", " CONTROL_TELEMETRY", " canmx4>, on<0>") ;
}

The DoReact method

The DoReact method generates actions for the objects. It sends the action to the specified object. The action is transferred directly to the kernel where the object belongs, and not to
the whole system. The action is specified using the MsgObject object.

Method call syntax

function DoReact(nsgevent : MgQbject)

Method arguments:

msgevent - Required argument. The action sent to the specified object. It takes the following values: MsgObject objects created earlier in the script.

Note

Two types of system messages are available in the Intellect system: events and actions.

The events usually contain some information and are used as notifications sent to all Intellect kernels connected to each other during the system setup.

The actions are the control commands sent to specific objects. An action is transmitted only to the kernel where the related object belongs, and not to the whole system.

The DoReactStr and DoReact methods are used to generate actions. The NotifyEventStr and NotifyEvent methods are used to generate events.

Usage examples
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Problem. When Relay 1 closes, close Relays 2 and 3. When Relay 1 opens, open Relay 2.

i f (Event.SourceType == "GRELE" && Event. Sourceld == "1")

var nmsgevent = Event. d one();
i f(Event.Action == "ON'")
{

nmsgevent . Sourceld = "2";
DoReact ( nsgevent) ;
nsgevent. Sourceld = "3";
DoReact ( nsgevent) ;

}
i f(Event. Action == "OFF")

{

nmsgevent. Sourceld = "2";
DoReact ( nsgevent) ;

The DoReactSetupCore method

The DoReactSetupCore method is used for changing the parameters of the object. It changes only the specified parameters, leaving other parameters intact.

Method call syntax

function DoReact SetupCore(objtype : String, id: String, paranckvalue> [, paranxvalue>] : String )
Method arguments
1. objtype - Required argument. The type of the object whose parameters are to be changed. It takes the following values: Type - String, range - existing object types.
2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification

numbers of the object of the specified type.
3. param<value> - Required argument. Several arguments of this type can be specified. The parameters of the action.

One parameter has the following syntax:
“param<value>", where

param - name of the parameter;



value - value of the parameter.

Several parameters have the following syntax:

“paraml<valuel>, param2<value2>...".

Elements of the list are separated by commas with no white space.

The param argument can take the following values: Type — String, range - available parameters of the specified action. The value argument can take the following values: Type -
String, range - depends on the parameter.

Usage examples

Problem. When Macro 1 starts, set the values of the following parameters of Cameras N21-4: PTZ device number (telemetry_id) and synchronous microphone number (audio_id). The
values should be equal to the camera numbers plus 1.

i f (Event. SourceType == "MACRO' && Event. Sourceld == "1" && Event.Action == "RUN')
{ .
var i;
for(i=1; i<=4; i=i+1)
{ DoReact SetupCore ("CAM', i, "telenetry_id<" + (i+1l) +"> audio_id<" + (i+1l) + ">");
}
}

The DoReactSetup method

The DoReactSetup method is used for temporary changing parameters of the object. It changes only the specified parameters, leaving other parameters intact.

Method call syntax

function DoReactSetup (objtype : String, id: String, paranxval ue> [, paranxkvalue>] : String )

Method arguments:

1. objtype - required argument. The type of the object the parameters of which are to be changed. It takes the following values: type - String, range - existing object types.

2. id - required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: type - String, range - existing identification
numbers of the objects of the specified type.

3. param<value> - required argument. Several arguments of this type can be specified. The parameters of the action.

One parameter has the following syntax:



“param<value>", where

param - name of the parameter;

value - value of the parameter.

Several parameters have the following syntax:
“paraml<valuel>,param2<value2>...".

Elements of the list are separated by commas with no white space.

The param argument can take the following values: values of the String type, range is limited by available parameters of the specified action. The “value” argument can take the
following values: values of the String type, the range depends on the parameter.

Example. When Macro 1 starts, temporary remove all cameras on the first monitor.

if (Event. SourceType == "MACRO' && Event. Sourceld == "1" && Event. Action == "RUN") 5
{
DoReact Setup ("MONI TOR', "1", " REMOVE_ALL","");
}
The DoReactGlobal method
The DoReactGlobal method is used to generate object reactions. The DoReactGlobal method transmits a reaction to the required object. The reaction is transmitted not only to the
kernel, where the object is registered, but to the whole system. For the DoReactGlobal method the reaction is specified by the MsgObject object.
Method call syntax
i function DoReactd obal (nsgevent : MsgQbj ect) 5
Method arguments:
msgevent - required argument. It sets a reaction transmitted to the required object. It takes the following values: MsgObject objects created earlier in the script.
Example. When macro 2 starts, guard on Sensor 2. The command is to be transmitted to all system kernels as the reaction to be registered in the Events Log.

i f (Event. SourceType == "MACRO'&& Event. Sourceld == "2" && Event.Action == "RUN'")
{

var msgevent = CreateMsg();

21
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nsgevent. Sour ceType = " GRAY";
nmsgevent . Sourceld = "2";
nmsgevent . Action = "ARM';
DoReact d obal (nsgevent);

The NotifyEventStr method

The NotifyEventStr method generates system events. Events are sent to all kernels connected to the local kernel. An event is specified as a group of String arguments.

Method call syntax

function NotifyEventStr(objtype : String, id : String, event : String, paranxvalue> [, parankval ue>]
String )

Method arguments:

1. objtype - Required argument. The type of the object that the event should be generated for. It It takes the following values: Type - String, range - existing object types.
2. id - Required argument. Identification number of the object of the type set in the objtype argument. It takes the following values: Type - String, range - existing identification
numbers of the object of the specified type.
3. event - Required argument. The event to be generated. It takes the following values: Type - String, range — available events for the objects of the specified type.
4. param<value> - Required argument. Several arguments of this type can be specified. The parameters of the event.
One parameter has the following syntax:
"param<value>", where
param - name of the parameter;
value - value of the parameter.
Several parameters have the following syntax:

"paraml<valuel>,param2<value2>...".

Elements of the list are separated by commas with no white space. If no parameters need to be specified, an empty string is used:
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The param argument can take the following values: Type - String, range - available parameters of the event. The value argument can take the following values: Type - String, range
- depends on the parameter.

Note

Two types of system messages are available in the Intellect system: events and actions.

The events usually contain some information and are used as notifications sent to all Intellect kernels connected to each other during the system setup.

The actions are the control commands sent to specific objects. An action is transmitted only to the kernel where the related object belongs, and not to the whole system.

The DoReactStr and DoReact methods are used to generate actions. The NotifyEventStr and NotifyEvent methods are used to generate events.

Usage examples

Problem. When an alarm is received, send the “panic lock” event corresponding to the camera region. For camera identification numbers from 1 to 4, use region 1; for camera numbers
from 5 to 10, use region 2.

if (Event. SourceType == "CAM' && Event.Action == "MD _START")
{
var regionid;
if (Event.Sourceld <=4)

{
regionid = "1";
}
if ((Event.Sourceld > 4) & (Event. Sourceld <= 10))
{
regionid = "2";
}
NotifyEvent Str("REG ON', regionid, "PANIC LOCK"', "");

The NotifyEvent method

The NotifyEvent method generates system events. The event is sent to all kernels connected to the local kernel. The event is specified using the MsgObject object.

Method call syntax

function NotifyEvent(nmsgevent : MgObj ect)



24

Method arguments:

msgevent - Required argument. The event sent to the system. It takes the following values: MsgObject objects created earlier in the script.

Note

Two types of system messages are available in Intellect system: events and reactions.

The events usually contain some information and are used as notifications sent to all Intellect kernels connected to each other during the system configuration.

The reactions are the control commands sent to specific objects.

The reactions are transmitted only to the kernel where the object belongs, and not to the whole system.

The DoReactStr and DoReact methods are used to generate reactions. The NotifyEventStr and NotifyEvent methods are used to generate events.
Example. When the Backup Archive 1 module starts archiving video recordings, the analog output 1 of the Video Capture Device 2 is disabled. Send the command as an event to be
registered in the Events Log.

Note

While executing this script, the analog output 1 of the Video Capture Device 2 is not disabled

if (Event.SourceType == "ARCH' && Event. Sourceld == "1" && Event.Action == "ACTIVE ")

var msgevent = CreateMsg();
nmsgevent . SourceType = " GRABBER ";
nmsgevent. Sourceld = "2";

nmsgevent . Acti on = "MJX1_OFF";

Not i f yEvent (msgevent);

The NotifyEventGlobal method

The NotifyEventGlobal method is used to generate system events. The generated event is transmitted to all system kernels connected via the net. For the NotifyEventGlobal method
the event is specified using the MsgObject object.

Method call syntax
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function NotifyEventd obal (nsgevent : MgObject)

Method arguments:

msgevent - required argument. It sets the event transmitted to the system. It takes the following values: MsgObject objects created earlier in the script.

Example. When Macro 1 starts, the first camera is set for recording. The command is to be transmitted to all system kernels as the event to be registered in the Events Log.

Note

While executing this script, cameral is not set for recording.

i f (Event. SourceType == "MACRO'&& Event. Sourceld == "1" && Event.Action == "RUN") |
{
var nmsgevent = CreateMsg();
nmsgevent . Sour ceType = "CAM',;
nmsgevent . Sourceld = "1";
nmsgevent . Acti on = "REC';
Not i f yEvent @ obal (nsgevent);
}
The CreateMsg method
The CreateMsg method creates objects based on the MsgObject prototype.
Method call syntax
5 function CreateMsg() : Msgnject |
Method arguments: no arguments.
Usage examples
Problem 1. When an alarm is received, send the “panic lock” event corresponding to the camera region. For camera identification numbers from 1 to 4, use region 1, for camera
numbers from 5 to 10, use region 2.



if (Event. SourceType == "CAM' && Event. Action == "MD_START")
{

var msgevent = CreateMsg();

nmsgevent . Sour ceType = "REGQ ON';

nsgevent. Action = "PANI C _LOCK";

if (Event.Sourceld <=4)

{ nsgevent. Sourceld = "1";

;ff ((Event. Sourceld > 4) & & (Event. Sourceld < 10))
{ nsgevent. Sourceld = "2";

I}\Iotinyvent(rrsgevent);

Problem 2. When timer N21 starts, start macro N°1 every 30 seconds.

Note

To start this script create the Timer object with ID=1 beforehand. Set value=1 to the Second parameter of the Timer object, leave other parameters without changing («Any
by default)

if (Event. SourceType == "TI MER' && Event. Sourceld == "1" && Event. Action == "TRI GGER")

{

var meg = CreateMsg();
nmsg. StringToMsg( Get Obj ect Parans("TI MER', "1"));

i f(nsg. GetParam("s") == "1")
{

DoReact Str("MACRO', "1", "RUN', "");
Set Qbj ect Paran(" TI MER", "1","s", "30");
DoReact Str (" TIMER', " 1", "DI SABLE", "");
DoReact Str (" TI MER', "1", "ENABLE"', "");

}
i f(nsg. Get Paran("s") == "30")

{
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DoReact Str (" MACRO', "1", "RUN', "");
Set Qbj ect Paran( " TI MER", "1", "s","1");
DoReact Str (" TI MER", "1", "Dl SABLE", "");
DoReact Str (" TI MER', "1", "ENABLE"', "");

The Lock and Unlock methods

The Lock and Unlock methods are used to create a global critical section when synchronization of scripts started in different streams is required. The Lock method opens a critical
section and the Unlock method closes it.

Attention!

Attention! If the Lock method has been called, then the Unlock method has to be called too. Otherwise the system can freeze.

It is recommended to avoid using the Lock and Unlock methods.

Method call syntax

5 function Lock() 5
5 function Unl ock() 5

Example. When Macro 1 starts, calculate total alarmed relays and sensors. Objects of each type are to be calculated at the same time (in an individual script). The result is to be stored
to “counter” global variable.

Script 1:

/1 Nunber of alarmed relays is cal cul ated
var i = Numnber (0);
if (Event.SourceType == "MACRO' && Event. Sourceld== "1" && Event.Action == "RUN")

{



var nsg = CreateMsg();
nmsg. Stri ngToMsg( Get Obj ect I ds(" GRELE"));
var obj Count = nsg. Get Paran{"id.count");
var Kk;
for(k= 0; k < objCount; k++)
i f(CGetbjectState("CGRELE", nsg. GetParanm("id." + k))== "ALARM'){
Lock();
i = ltv_var("counter");
i ++;
Itv_var("counter")=i
Unl ock() ;

..........................................................................................................................................................................................................................................................................

........................................................................................................................................................................................................................................................................

/I Nunber of alarmed sensors is cal cul ated
var i = Number (0);
i f (Event. SourceType == "MACRO' && Event. Sourceld== "1" && Event.Action == "RUN")
{
var nmsg = CreateMsg();
nsg. Stri ngToMsg( Get Obj ect | ds(" GRAY") ) ;
var obj Count = nsg. Get Paran{"id.count");
var k;
for(k = 0; k < obj Count; k++)
i f(Get bj ect State("GRAY", nsg. GetParam("id." + k))== "ALARMED") {
Lock();
i = I1tv_var("counter");
i ++;
Itv_var("counter")=i
Unl ock();

..........................................................................................................................................................................................................................................................................
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Note

If the Lock() and Unlock() methods are not used in this example, then collisions may occur and calculated value will be less than a real one

The IsAvailableObject method

The IsAvailableObject method is used to determine the current access rights to an object.

Method call syntax:

funct

ion |sAvail abl e(bject(conpnane: String, objtype: String, id: String, param: String) : String

The method returns 0 if the current user has not been assigned access rights of type param for the object; it returns 1 if these rights have been assigned.

Method arguments:

1.
2.

3.

For example:

compname - required. Corresponds to the name of the Computer object on which the object was created in the hardware tree.

objtype - required. Corresponds to the type of the system object to which access rights are are being checked. Allowed values: String type; the set of values is restricted to
the object types registered in the system.

id - required. Corresponds to the identification (registration) number of the object of the type specified by the objtype argument. Allowed values: String type; the set of values
is restricted to the identification numbers of objects of the specified type, which are registered in the system.

. param

system
1.

ounkwnN

to the object:

var i

for(i

- required. Corresponds to the number of the type of rights which are being checked. A description of rights is given in Limiting access to the administration of the
objects, control and viewing functions of the Administrator’s Guide. Allowed values:

0 - NoView access rights. The method will return 1 if there are no administrative, control-, or viewing rights for the object (red 'x").

1 - NoControl access rights. The method will return 1 if there are only viewing rights (letter M).

2 - ViewAndControl access rights. The method will return 1 if there are control- and viewing rights for the object (green box).

3 - ViewOrControl access rights. The method will return 1 if there is either viewing or control rights for the object.

4 - Not access rights (e.g. no access rights).

5 - Configure access rights. The method will return 1 if there are administrative, control- and viewing rights for the object (gray box).

Based on a Computer object named "S-UYUTOVA", a Camera object with the identifier 1 has been created in the hardware tree. To determine the current access rights

1
o

0; i <=5; i++4)

var result =


https://doc.axxonsoft.com/confluence/display/Int411en/Limiting+access+to+the+administration+of+the+system+objects%2C+control+and+viewing+functions
https://doc.axxonsoft.com/confluence/display/Int411en/Limiting+access+to+the+administration+of+the+system+objects%2C+control+and+viewing+functions
https://doc.axxonsoft.com/confluence/pages/createpage.action?spaceKey=Int411en&title=Administrator%E2%80%99s+Guide&linkCreation=true&fromPageId=136250366
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| sAvai | abl ebj ect (' S-UYUTOVA' ,"' CAM , ' 1", i);

DebugLogString("right "+i+" = "+result);

}
The GetUserld method
The GetUserld method returns the identifier of the current Intellect Software System user.
Method call syntax:
. function GetUserld (cnp : String) : String |

Method arguments:

1. cmp - required. Specifies the name of the computer on which the Intellect Software System is installed. Allowed values: values of String type that satisfy the requirements for
computers' network names; the set of values is restricted to the names of computers registered in the system.

For example: To display the identifier of the current user of the Intellect Software System, which has been installed on a computer named 'WS3":

. DebuglLogString(Get User | d("W83")): i
The GetEventDescription method
The GetEventDescription method is in use for receiving the object description on free language.
Syntax of method invocation:

. function GetEventDescri ption (obj type : String, event : String) i

Method arguments:

1. obj_type - required argument. Specifies type of system object description of which is required to get.
2. event - required argument. Specifies the name of object description of which is required to get.



Example. Display messages about receiving of events for camera 1 on the free language in the Debug window.

N (Event. Sour ceType == "CAM && Event. Sourceld == "1") |
{ |
var str = GetEventDescription("CAM', Event.Action);
DebugLogString(str);

! i

The GetObjectldByParam method

The GetObjectldByParam method allows receiving of object ID at which some parameter is equal to the specified value. The first found object ID is receiving if there are several such
objects. The null is receiving if such objects are not found

Syntax of method invocation:

i function Get ObjectldByParam (obj type : String, obj param: String, paramvalue : String) |
Method arguments:

1. obj_type - required argument. Specifies type of system object, ID of which is required to get.

2. obj_param - required argument. Specifies the name of parameter in database on value of which the object is to be found.

3. param_value - required argument. Specifies the required value of object parameter.
Example. Find cameras from which black-and-white image is receiving and set the Color parameter equals to 1 for them.

if (Event. SourceType == "MACRO' && Event. Sourcel d== "1" && Event.Action == "RUN")

var id = Get Cbject! dByParam"CAM',"color","0"); //receiving the first object ID

while (id){ //while exist the Canera objects from which bl ack-and-white inage is receiving
Set hj ect Param ("CAM', id, "color", "1"); //change the Col or paraneter for found object
id = GetnjectldByParanm("CAM', "color","0"); //receiving the next object ID

The SaveToFile method
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SaveToFile method is in use to save in file the frame from camera receiving in the data parameter of FRAME_SENT event.

Syntax of method invocation:

function SaveToFile (path: String, data: String, param: Bool ean)

..........................................................................................................................................................................................................................................................................

Saving of frame is also can be performed using the GET_FRAME reaction of the CAM object. It is required to specify the path for saving file with frame in the path parameter of this
reaction. FRAME_SENT event is created in the system if the GET_FRAME reaction has not got the path parameter. In the data parameter of the FRAME_SENT event the video image
frame which is to be saved using the SaveToFile method is stored.

The reaction allows exporting of video image frame even if the camera is not displaying in the Monitor window.
Method argument:

1. path - mandatory argument. Specifies the full path to save the file with frame.

2. data - mandatory argument. Specifies data to save in file.

3. param - mandatory argument. Defines necessity of conversion from base 64 format before saving. Possible parameter values:
1. true - decode from base64 before saving;
2. false - save string without conversion.

Time of frame saving depends on the anchor frames frequency. The higher the anchor frames frequency, the less time.

Example. Save the frame receiving from Camera 1 in the test.jpg file on the D disk:

if (Event. SourceType == "CAM' && Event. Sourceld == "1" && Event.Acti on == "FRAME_SENT")

{
SaveToFil e("D:\\test.jpg", Event. Get Paran("data"), true);

The GetLinkedObjects method

The GetLinkedObjects method is used to get list of objects linked to the specified camera using the Objects connection object ( see the Administrator's Guide, Connection of objects
with cameras section)

Method call syntax:

function GetLinkedObjects(typel : string, id : string, type2 : string)

..........................................................................................................................................................................................................................................................................
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Method argument:
1. typel - the type of object for which linked objects are to be returned.
2. id - identification number of object for which linked objects are to be returned.
3. type2 - the type of linked objects which are to be returned. If empty string is sent then linked objects of all types will be returned.

Example.

The Objects connection object is configured the following way:

Display in debug window the list of objects linked with the camera 1.

if (Event. SourceType == "MACRO') |
{
varnsgstr = GetLi nkedObj ects("CAM', "1", " MACRO")
DebugLogSt ri ng("Li nked objects " + nsgstr);
}
As a result the "Linked objects MACRO:1" message will be displayed in the script debug window.
The WriteIni method
The WriteIni method is used for writing the string variable to ini-file.
Method call syntax:
function Witelni(varName: String, varValue: String, path: String) 5

Method argument:

1. varName - required argument. Sets name of variable for saving in the file.
2. varValue - required argument. Sets value of t variable.
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3. path - required argument. Sets full path to the ini-file in which variable is to be stored. Storage of variables can be replaced on the network resource. Enter the network path
in the argument for it.

Example. Write the MyVar variable to the \\fs\temp\test.ini file and specify the «Helloworld!” value to it. Then read the written value and display it on the script debug window.

Witelni ("MyVar", "Hello world", "\\\\fs\\tenp\\test.ini"); i
var result = Readlni("M/Var","\\\\fs\\temp\\test.ini");
DebuglLogString(result); i
The ReadIni method
The ReadInimethod is used to read values of string variablein the ini-file.
Method call syntax:
function Readlni (varNanme: String, path: String): String 5
Method call syntax:
1. varName - required argument. Sets name of the variable storing in the file.
2. path - required argument. Sets the full path to the ini-file in which variable is storing.
See example in The WriteIni method section.
The AddIni method
The AddIni method is used to write, change and read integer variable from the ini-file. The method returns the value of variable after its changing.
Method call syntax:
. function Addl ni (varName: String, varValue: int, path: String): int |

1. varName - required argument. Sets the name of variable in the file.
2. varValue - required argument. Sets the value of variable or value which should be added to the existing value of variable:

1. The varValue value will be assigned to the variable if there is a file with the varName name and string value in the file.
2. If there is no variable with the varName name in the file then such variable will be created and the varValue value will be assigned to it.



3. If there is a variable with the varName name in the file and it has integer value or its value is indicated to the integer type, then value will be indicated and the varValue

value will be added to it.
3. path - required argument. Sets the full path to the ini-file in which variable it to be stored. Storage of variables can be placed on the network resource. Enter the network path

in the for it.

Example. There is no the "MyVar" variable in the "C:\\test.ini". Write such variable with the -1 value to the file, then add 1 to it and display the result value on the script debug window.

. var result = Addlni ("MyVar", -1, "C\\test.ini");
result = Addini ("MyVar", 1, "C\\test.ini");
DebuglLogStri ng(result); i
The SetTimer method
The SetTimer method is used to start the timer.
The syntax for accessing the method is:
. function SetTimer (id: int, mlliseconds : int) |

Method arguments:

1. id is a required argument. It specifies the timer ID. Allowed values are int or string type.
2. milliseconds is a required argument. It specifies the period with which the timer will trigger if it is not stopped by the KillTimer method. It is specified in milliseconds. Allowed

values are int type.

Example. 2 seconds after the macro 1 is executed, start recording on camera 1.
i f (Event. SourceType=="LOCAL_TI MER" && Event. Acti on=="TRI GGERED" && Event. Sourcel d==333) //it is possible to use
Event. Sourceld == "333", i.e. string ID

{
var actuallyKilled = KillTimer(333);
if(actuallyKilled == 1)
{
[bReaCt St r(n CAMI , n 1|| , n REC‘ , n n);
}
}
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i f (Event. SourceType=="MACRO'&& Event. Sourceld == "1" && Event.Action == "RUN")

{
Set Ti mer (333, 2000); //333 - id, 2000 nsec = 2 sec - period

The KillTimer method

The KillTimer method is used to stop the timer. Returns 1 if timer was stopped as a result of function executed.
The syntax for accessing the method is:

..........................................................................................................................................................................................................................................................................

Method arguments:

1. id is a required argument. It specifies the timer ID. Allowed values are int or string type.
Example. See in the The SetTimer method section.
The GetObjectChildIds method

The GetObjectChildIds method returns IDs of child objects of specified type created under given object.

Method call syntax

function GCetCObjectParentld(parent : String, id : String, objtype : String) : String[]

..........................................................................................................................................................................................................................................................................

Method arguments:

1. parent - Required argument. The type of the object for which you want to find out child objects . It takes the following values: Type - String, range - existing object types.
2. id - Required argument. Identification number of the object of the type set in the parentargument. It takes the following values: Type - String, range - existing identification

numbers of the objects of the specified type.
3. objtype - Required argument. The type of the child objects whose identification numbers should be returned. It takes the following values: Type - String, range - existing

object types.

Example. Arm all cameras on WS2 computer on Macro 1.

i f (Event.SourceType == "MACRO' && Event.Action == "RUN' && Event. Sourceld == "1")

{
var children = Get Obj ect Chil dl ds(" SLAVE", " DESKTOP- UBCS6BK", " CAM') ;
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ch=children.split(",");
for (i=0;i<ch.length; i++)

{
DoReact Str (" CAM', ch[i],"ARM', "");

The MsgObject and Event objects and their built-in methods and properties
The MsgObject and Event objects

MsgObject is a prototype (template) used to create objects with methods and properties for handling events. The methods and properties of MsgObject allow receiving the
information about objects that send or receive events, generating actions, changing object states, etc.

The methods and properties of the MsgObject prototype can be called via its instance objects or the Event static object.

Event is a static object used to call events in Intellect. The Event object represents the system event that launched the script. All MsgObject methods and properties are available for
the Event object.

The CreateMsg method of the Core object is used to create instances based on the MsgObject prototype.

The GetSourceType method
The GetSourceType method returns the type of the MsgObject or Event object.

Method call syntax

function GetSourceType() : String

Method arguments: no arguments.

Usage examples

Problem. When Macro 1 starts, arm Detection Zones *.1 in the Day mode for Cameras N2 1 - 4. When Macro 2 starts, arm Detection Zones *.2 in the Night mode for Cameras N2 1 -
4. When Macro 3 starts, arm Detection Zones *.3 in the Rain mode for Cameras N2 1 - 4.

Note

Symbol "*" corresponds to identification number of a camera in the system (from 1 to 4)



i f (Event. Get SourceType() == "MACRO' && Event. GetAction() == "RUN")

{
var Kk;
/1Switching the caneras to the Day node by arming the *.1 detection zones
i f(Event. GetSourceld() == "1")
{
for (k =1; k<=4; k = k+1)
{

DoReact Str("CAM ZONE", k + ".1", "ARM', "");
DoReact Str("CAM ZONE", k + ".2", "DISARM', "");
DoReact Str (" CAM ZONE", k + ".3", "DI SARM', "");
}
}
/1Switching the caneras to the Nigh node by arming the *.2 detection zones
i f(Event. Get Sourceld() == "2")
{
for (k =1, k<= 4; k = k+1)
{
DoReact Str (" CAM ZONE", k + ".1", "DI SARM', "");
DoReact Str("CAM ZONE", k + ".2", "ARM', "");
DoReact Str (" CAM ZONE", k + ".3", "D SARM', "");
}
}
/1Switching the caneras to the Rain node by arming the *.3 detection zones
i f(Event. Get Sourceld() == "3")
{
for (k = 1; k<=4; k = k+l)
{

DoReact St r (" CAM ZONE"
DoReact St r (" CAM _ZONE"
DoReact St r (" CAM _ZONE",

}
}

".1", "Dl SARM', "");
".2", "D SARM, "");
".3", "ARM', "");

~ X X

+
+
+

}
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The GetSourceld method

The GetSourceld method returns the identification number of the MsgObject or Event object.

Method call syntax

function GetSourceld() : String
Method arguments: no arguments.
Usage examples

See the example for the GetSourceType method.

The GetAction method

The GetAction method returns the event received as an Event object or specified for a MsgObject object.

Method call syntax

function GCetAction() : String
Method arguments: no arguments
Usage examples

See the example for the GetSourceType method.

The GetParam method

The GetParam method returns the value of the specified parameter of the MsgObject or Event object.

Method call syntax

function GCetParamparam String) : String
Method arguments:

param - required argument. The name of the parameter of the object created using MsgObject (or of the Event object). It takes the following values: type - String, range -
available parameters for the objects of the specified type.
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Note

If the object has no parameter with this name, then the method restores an empty string

Example. When any event from any camera is registered, check from which computer the event comes. If the computer has "WS3"” name, create the event copy where the computer’s
name is “Computer”.

i f (Event. SourceType == "CAM")
{
var msg = Event. C one();
if (msg. GetParan("slave_id") == "W53")
{

neg. Set Paranm("sl ave_id", "Conputer");
Not i f yEvent (nsq) ;

}

}

The SetParam method

The SetParam method assigns a value to the specified parameter of the MsgObject or Event object. It changes only the specified parameters, leaving other parameters intact.

Method call syntax

function SetParamparam: String, value : String)

Method arguments:

1. param - Required argument. The name of the parameter of the object created using MsgObject (or of the Event object). It takes the following values: Type - String, range -
available parameters for the objects of the specified type.
2. value - Required argument. The value to be assigned to the parameter specified in the param argument. It takes the following values: Type - String, range - depends on the

parameter.

Usage examples

See the example for the GetParam method.

The MsgToString method

The MsgToString method transforms MsgObject objects (including the static Event object) into a String variable.

Method call syntax
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function WMgToString() : String

Method arguments: no arguments.
Usage examples

Problem. Send the messages about all events registered for Microphone 1, to a specified e-mail address.

Note

The Short Messages Service is supposed to be installed and working properly.

if (Event. SourceType == "COLXA LINE" && Event. Sourceld == "1")

{

var negstr = Event.MsgToString();
DoReact Str (" MAI L_MESSAGE", "1", "SEND', "subject<M crophone 1>, body<" + msgstr + ">");
DoReact Str (" MAI L_MESSAGE", "1", "SEND', "");

}

The StringToMsg method

The StringToMsg method transforms a String variable into an MsgObject object.
Method call syntax

StringToMsg(msg : String) : MsgObject

Method arguments:

msg - Required argument. A String type variable to be transformed into an MsgObject object. It takes the following values: Type - String; range - character string that matches the
syntax for MsgObject representation:

"objtypelid|action|paraml<valuel>,param2<value2>..", where
objtype - object type;
id - object identification number;

action - event or action for the object;
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paraml<valuel>,param2<value2> - list of parameters and their values. Elements of the list are separated by commas with no white space. If no parameters need to be specified,
an empty string is used after the vertical line (]), for example:

"CAM|1|MD_START|"

Usage examples

Problem. Upon an alarm in Sensor 1 or 3, start recording audio from Microphone 1. Upon an alarm in Sensor 2 or 4, start recording audio from Microphone 2.

i f (Event.SourceType == "GRAY" && Event.Action == "ALARM')
{
var audi oi d;
if (Event.Sourceld == "1" || Event.Sourceld == "3")
{
audioid = "1";
}
if (Event.Sourceld == "2" || Event.Sourceld == "4")
{
audioid = "2";
}
var str "CLXA_LI NE| " +audi oi d+"| ARM ";
var nsg CreateMsg();
nmsg. StringToMsg(str);
Not i f yEvent (nsQ) ;

The StringToParams method

The StringToParams method transforms a String variable into the list of parameters and overwrites the existing parameter list of the MsgObject object.

Method call syntax

StringToParans(String parans)

Method arguments:

params - Required argument. A String type variable to be transformed into a list of parameters for the MsgObject object. It takes the following values: String variables matching the
syntax for MsgObject parameter list representation:
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“paraml<valuel>,param2<value2>...", where

paraml<valuel>,param2<value2> - list of parameters and their values. Elements of the list are separated by commas with no white space. If no parameters need to be specified,
an empty string is used after the vertical line (|), for example:

“CAM|1|MD_START|”
Usage examples

Example. Upon registration the connection (“Attach”) event for any camera, in the system retrigger the “Attach” event with modified Number of the PTZ device (telemetry_id) and N
umber of the microphone for synchronous recoeding (audio_id) parameters. The values should be equal to the corresponding camera numbers plus 1.

if (Event. SourceType == "CAM' && Event. Action == "ATTACH'")
{

var i;
for (i=1,i<=4;i=i+1)
{

var nmsg = Event. d one();

var str = "telenmetry id<" + (i+1) +"> audio_id<" + (i+1) + ">";
nsg. StringToParans(str);

Not i f yEvent (nsq) ;

The Clone method

The Clone method creates a copy of an MsgObject or Event object.

Method call syntax

Cone() : Msgnhj ect
Method arguments: no arguments.
Usage examples

Problem. When Relay N91 closes, start video recording from Camera 1 and close Relay N22. When Relay N?1 opens, start video recording from Camera 2 and open Relay N92.
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if (Event. SourceType == "GRELE" && Event. Sourceld == "1")
{

var msgevent = Event. d one();
i f(Event.Action == "ON")
{

nmsgevent . Sourceld = "2";

DoReact ( nsgevent) ;

DoReact Str("CAM',"1","REC',"");
DoReact Str (" GRELE", "2","ON',"");

}
i f(Event. Action == "OFF")

{

nsgevent. Sourceld = "2";

DoReact ( nsgevent) ;

DoReact Str("CAM',"2","REC","");
DoReact St r (" GRELE", "2","OFF","");

The GetObjectIds method

GetObjectlds method is responsible for receiving identifiers from all the objects of a specified type.

Method call syntax:

function Get hjectlds(objectType : String)

A line is replied :
CAM||COUNT]id.3<5>,id.count<4>,id.0<2>,id.1<3>,id.2<4>
where id.count<> - number of ID objects,

id.[count]<> - ID object.

Method’s arguments:
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objectType -required argument. Set the type of the system object, for which the value of the given parameter should be given back ("CAM","GRAY","GRABBER" e.t.c.).Accepted
values: type String, range is restricted by object types registered in the system.

Example. All the cameras should be armed upon the start of MacrosN?1.

if (Event. SourceType == "MACRO' && Event. Sourceld && Event.Action == "RUN")
{
var nmsg = CreateMsg();
nmeg. StringToMsg( Get Obj ectlds(" CAM'));
var obj Count = nsg. Get Paran{"id.count");

var i;
for(i = 0; i < objCount; i++)
{
DoReact Str("CAM', nsg. GetParam("id." + i), "ARM, "");
}
}
The GetObjectParams method
GetObjectParams method is designed for getting the object’s parameters.
Method call syntax:
function Get Qbj ect Parans(obj ect Type : String, objectld : String) |

Method arguments:

1. objectType - required argument. Set the type of the system object ("CAM", "GRAY", "GRABBER" e.t.c.), for which the type of a parent object should be given back. Accepted
values: type String, range is restricted by object types registered in the system.
2. objectId - object’s identifier. Accepted values: String type.

Example. It is necessary to check the color control of camera N°2 upon the start of MacrosN?1. If camera 2 is a color one, set it to recording.

if (Event.SourceType == "MACRO' && Event. Sourceld && Event. Action == "RUN")
{
var msg = CreateMsg();
nsg. Stri ngToMsg( Get Obj ect Parans(" CAM', "2"));
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i f(nmeg. Get Param("color") == "1")

{
DoReact Str (" CAM', "2", "REC', "");

The SourceType property

The SourceType property stores the system type of the MsgObject or Event object.

Property call syntax

SourceType : String 5
Usage examples
Problem. When Relay 1 closes (for example, the button connected to the relay is pressed), print the frames from Cameras 1 and 2.
| if (Event. SourceType == "CGRELE" && Event. Sourceld == "1" && Event.Action == "ON'") i
{ i
/lactivating the Canmera 1 wi ndow
DoReact Str("MONI TOR', "1", "ACTI VATE_CAM', "canxl>");
[lprinting the frame from Canmera 1 :
DoReact Str("MONI TOR', "1", "KEY_PRESSED", " key<PRI NT>") ; 5
/lactivating the Canera 2 w ndow f
DoReact Str("MONI TOR', "1", "ACTI VATE_CAM', "canx2>");
[lprinting the frame from Canera 2
DoReact Str("MONI TOR', "1", "KEY_PRESSED", " key<PRI NT>") ; :
} |
The Sourceld property
The SourceType property stores the identification number of the MsgObject or Event object.
Property call syntax
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Sourceld : String

Usage examples

See the example for the SourceType property.

The Action property

The Action property stores the action or event of the MsgObject or Event object.

Property call syntax

Sourceld : String

Usage examples

See the example for the SourceType property.

Programming tools
The Script object

The Script object is designed for initializing and setting the parameters of JScript scripts in Intellect system.

Figure shows the settings panel for the Script object.
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Attention!

Creating of large number of the Script objects (more than 100) can result to instable system working.

The settings panel allows choosing the time zone and the computers (kernels) for executing the script.

Note.

To set all checkboxes checked select one in the column and click Ctrl+A. To set all checkboxes unchecked select one and click Shift+A.

It also has the button for starting the Editor-Debugger tool and the text window for viewing the script text created by means of this tool. The scripts can be edited in the Editor-
Debugger tool or directly in the settings panel for the Script object.



Moreover, one can configure the filter of events - the list of events which are to be processed by the Script system object. In general, including the event to the filter equals to if
operator in the text of script, i.e. when the event is in the table, the operator can be omitted.

Attention!

The event filter is to be set when creating a script in large distributed configurations. Otherwise the module will process all incoming events and it will lead to module
malfunctioning.

Example

If the Object’s type column has the Macro value, the Identifier column has the 1 value and the Event column has the Executed value, then

if (Event. SourceType == "MACRO' && Event. Sourceld==1 && Event.Action == "RUN'")
A
| DoReact Str (" CAM', "2", "REC', "");
o}
script can be used instead of script.
DoReact Str (" CAM', "2", "REC', ""); i

...........................................................................................................................................................................................................................................................

The detailed information on the elements of the settings panel for the Script object is given in Administrator's guide.

Example.
Recording on Camera 1 is to be started when controlling PTZ device in the Video surveillance monitor.
For this adjust the Script object as follows:

1. Select the required time zone when the script is to be executed.
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2. Enter the script text:

- Run on specified computers
I‘I IScrlpt‘I
| Computer | M ame
[ Disable BA 5-UvUTOWA  LOCALHOST
Time zcheduls |A|wa_l,J;g j 1] | _PI
if (Event.GetParam("source type") == "ITELEMETRY") {
DoReactStr ("CAM","1", "EEC","");
}
| i

Editor - Diebugger |

Object's type | Ide... | Object's name
CORE
Apphy Cancel

3. Adjust the filter as follows:
1. Select CORE in the Object’s type dropdown list.
2. Enter DO_REACT in the Event field.

The filter can be set by the UPDATE_OBJECT event of the CORE object. Example command to add Camera 1 object to the Script 2 filter:

Noti fyEvent Str (" CORE","", " UPDATE_OBJECT", "obj t ype<SCRI PT>, obj i d<2>, EVENT. obj i d. 0<1>, EVENT. obj i d. 1<10>, EVENT. acti on. count <2>, f | ags<>, EVENT. act i on. 0<>, EVENT.
action. 1<>, EVENT. obj t ype. 0<CAM>, EVENT. obj t ype. count <2>, EVENT. obj t ype. 1<CAM>, EVENT. obj i d. count <2>");

The Editor-Debugger utility

The Editor-Debugger utility is designed for creating, debugging and editing scripts in the Intellect software package.

Figure shows the Editor-Debugger dialog window.
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The Editor-Debugger utility contains the built-in text editor and the debugger window.

To help with writing correct codes, the text editor automatically highlights objects, methods and properties in different colors.

Note.

The position of the cursor in each script is stored in the context of one Intellect session (the cursor position is reset at the product restart). For example, if you place the
cursor at the end of //Line 2 in Script 1, then switch to Script 2 and perform any action in it, the cursor will be still at the end of //Line 2 when you return to Script 1.
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%% Script 1
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The debugger window allows viewing the information about all events registered by the system. You may filter the events to be shown in the debugger window. A separate debugger
window is created for each Script object, which allows each script to be debugged individually using the filters.

To debug a script, the utility can generate test events which will not be registered by the system.

Scripts can be saved as Script objects or as text files on the hard drive.

The Debug window

Intellect allows viewing all events and reactions happening in the system in real time mode. Events and reactions with object properties are displayed in the Debug window. They can
be copied to the Windows clipboard and then used in programs.

Enabling the Debug window

By default the debug window is disabled. To enable the debug window, do the following:

1. Shut down Intellect.
2. Run the Tweaki.exe utility.

Note.

The Debug window can be enabled without the tweaki.exe utility. For this set values 1, 2 or 3 for the Debug string parameter in the
HKEY_LOCAL_MACHINE\SOFTWARE\ITV\Intellect section of the Windows registry (HKEY_LOCAL_MACHINE \Software\Wow6432Node\ITV\Intellect for 64-bit system).

Select Intellect section in the tree on the left side of the utility dialog box.

Change the value of the Debug mode parameter from Disabled to Debug 1, Debug 2 or Debug 3.
Click the OK button.

Start Intellect.

A new Debug window item appears on the Main control panel of Intellect.

Nouhkuw
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Note.

This menu is also available in the Windows notification area (system tray) - left click on the il button or short click the F8 hot key.
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8. Select the Debug window item on the Main control panel in order to display the Debug window on the monitor. The selected Debug window item is marked with a flag.
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5] Logoff

To hide the Debug window, re-select the Debug window item on the Main control panel.

Note.

To disable the Debug window, select the Disable value for the Debug mode in the tweaki.exe utility or set value 0 for the Debug string parameter in the
HKEY_LOCAL_MACHINE\SOFTWARE\ITV\Intellect section of the Windows registry (HKEY_LOCAL_MACHINE \Software\Wow6432Node\ITV\Intellect for 64-bit system). These
actions are performed when Intellect is exited.



Working with Debug window

Look at the figure of the Debug window. The Debug window displays the sequence of events and reactions in the system.

Clear | Colors | Filber | ™ Apply filter Search |

4]

React : OPERATORPROTOCOL|1|DEACTIVATE|  slave id=S-UYIUTOWA. 1= panel_active <=, user_id<>
Event : CORE||[DISPLAY _CHANGE_ACTIVE|date <07-10-14 =, fraction <609, gui<1 =, guid_pk<{7EZ3C00A-DD4D-E41 1-B666-001 636069930 =, ovwner <5-UYUTCOWA >, lime <08:5:
Event : DISPLAY|1|ACTIVATE|date <07-10-14 = Fraction <326, quid_pk<{6223C00a-DD40-E41 1-B666-001636069930} =, owner <5-UYUTOWA = panel_active <0 slave id<S-U
React : MONITOR|1|ACTIVATE|_ slave_id<S-UYUTOVA =, panel_active<0=> user_id<>
React | SLAYE|S-UYUITCOVA|DISPLAY CHAMGE_ACTIVE|display id<1
Event : CORE||DISPLAY _CHANGE_ACTIVE|date <07-10-14 =, fraction <343, gui<1 =, guid_pk<{8323C004-DD4D-E41 1-B666-001 636069930 =, ovwner <5-UVUTCOWA =, lime <08:5:
Event : CAM|3|DETACH|care_global<1 = date<07-10-14 =, fraction <125, quid_pk<{008AGEEE-DD4D-E41 1-B6A6-001636063930} =, awner <S-LYUTOVA =, slave_id<S-LIVUTOWA
React : MOMITOR|1[REMOVE_ALL|_ slave_id=3-UvUTOVA =
React : MOMITOR|1]ADD]__slave_id=S-UYUTOVA =, arch_id <>, audio_id < =, audio_type <> cam<1 =,cam_zone_count <0, compression < =, compressar < =, control <1 =, decompre
React : MOMITOR|1]ADD]__slave_id=S-U¥UTOVA >, arch_id <=, audio_jd <>, audio_type <> cam«2=,cam_zone_count <0, compression < =, compressor <, control <1 =, decompre
React : MOMITOR|1|SETUP|43<0=, CAM, arch.0< =, CAM. arch, 1 <=, CAM, arch. 2 < =, CAM. arch, count <3 =, CAM. cam. 01 =, CAM,. cam, 1 <2 >, CAM,cam. 2 <3 =, CAM. cam. counk <3 >
Ewvent : MONITORlllACTIVATE CAMlcam::l:: core globa|{1> date=07- ID 14:= Fractlon{828> gdeJk:i{SUSAD?SS DE4D E411- 8666 001636D6993D}} awner =5- U‘r’UTO'v'A‘*

) d SaD =

Here are the features of the Debug window:

always on top;

the size of the Debug window is changed using the mouse;

information on event or reaction can be copied to the Windows clipboard and then used in programs;
events and reactions can be filtered in the Debug window;

A WNH



55

5. events and reactions can be highlighted in the Debug window;
6. it is possible to search for events or reactions in the Debug window.

Regular expressions can be used in order to highlight and filter messages in the Debug window.
Copying information on event or reaction to the clipboard

To read and/or copy data on event or reaction to the Windows clipboard, do the following:

1. Highlight the required line in the Debug window.
2. Right-click on the highlighted line. The Info window with info on required event or reaction appears.
3. Highlight the information that is to be copied to the Windows clipboard and click Ctrl+C.

Note.

Use the context menu for operations with text in the Info window (right-click on the highlighted text).

4. To close the Info window, click the EI button.

Debug window

Clear | Colors | Filker

||— M Information

: CAM|3|DETACH|core_global<1 =, date <07-10
s MOMITOR |1 |REMOVE_ALL|__ slave_id=35-UYL
s MOMITOR|1]ADD| _slave_id<S-UYLTOYA =, 2
: MOMITOR|1|ADD|_ slave id<S-UYLTOMA =,
: MOMITOR| 1 |SETUP|43<0%,CAM.arch, D<=,
: MOMITOR| 1| ACTIVATE_CAM|cam<1 = core_c
: MOMITOR| 1| ACTIVATE _CAM|cam<1 >, core_g

: OPERATORPROTOCOL|L|DEACTIVATE] _ slaw
: CORE|[DISPLAY_CHANGE _ACTIVE|date<07-1
: DISPLAY[1|ACTIVATE|date <07-10-14 > fracti
: MOMITOR| 1| ACTIVATE| _ slave_id<S-UvUTO"

SLAYE |S-UVUTOVA|DISPLAY _CHAMNGE _ACTIY
'E||DISPLAY CHAMGE ACTIVE|dal

01636063930} =, owner <3-UYUTOMA =, time <03 5;
ner <3-UYUTOMA =, panel_active <0z, slave_id<5-11%

WUTOVAZ, slave_id<3-UVUTOVA

mpression < >, compressaor <=, contral <1 =, decompre
mpression <, campressor <=, control <1 =, decompre
.cam. 1 =2>,CaM.cam.2 <35>, CAM.cam. counk <3 =,
E411-BE66-0016360699300) =, ownet <5-LYUTOWA =
E411-BE66-0016360699300) =, ownet <5-UYUTOYA

»

Information on event or reaction is now copied to the Windows clipboard.

Highlighting messages

To configure message highlighting in the Debug window, do the following:
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1. Click the Colors button.

il Debug window )

Clear K Colars P Filker | [~ Apply filker Search |

ounkw

B

React

d

React :
Ewvent :
Evenk :
Reack :
1 SLAYE|S-UVUTOVA|DISPLAY _CHAMGE_ACTIVE |display i ||:I~::1:b

Ewvent :
React :
Reack
Reack :
React :
Ewvert :
Ewvent :

OPERATORPROTOCOL|1|DEACTIVATE|  slave_id <S5-L¥UTOWA, 1 =, panel_active ==, user_id< =

CORE||DISPLAY _CHAMGE_ACTIVE |date<07-10-14 =, fraction <609, gui=1 =,quid_pk<{7E23C0DA-D04D-E411-B666-001 636063930 =, omner <5
DISPLAY|1|ACTIVATE|date <07-10-14 =, Fraction <328 =, guid_pk={5223C00A-D040-E411-B666-001636069930} =, awner <5-UYLUTOMA >, panel_a
MOMITOR| 1| ACTIVATE|  slave id<S-UYUTOWA =,panel_active<0=,user_id=>

: CORE||DISPLAY CHAMGE ACTIVE

M| 3|DETACH|care_glabal<1 =, date<07- 1014 fraction <125, guid JJk:i-{DEIBF\E.BEE -DDAD-E411-B66- DEIIE.SE.DE.QQSD}:: T LI"r'UTO'u'.C\
MOMITOR |1 [REMOVE_ALL|_ slave_id<S-UYUTOMA =

MOMITOR|1|A00D]_slave_id=S-UYUTOWA =, arch_id< =, audio_id <>, audia_tvpe < =,cam<1 =, cam_zone_count <0, compression <=, compressar <
MOMITOR|1]ADD| _ slave id=<5-I¥UTOMA >, arch_id ==, audio_id=<>,audio_tvpe <= cam=2=,cam_zone_count <03, compression <=, Compressar <
MOMITOR|1|SETUP|43<0=,CAM, arch,0< =, CAM,arch, 1 <>, CAM, arch, 2 <=, CAM, arch, count <3 =, CAM, cam, 0 <1 =, CAM, cam, 1 <2 =, CAM,cam, 242
MOMITOR |1 | ACTIVATE_CAM|cam<1 = care_global<l > date<07-10-14 > fraction <825 =,quid_pk<{305AD763-DE4D-E41 1-BE66-001636069930 )
MOMITOR |1 | ACTIVATE_CAM|cam<1 = care_global<l > date<07-10-14>, fraction <937 =,quid_pk<4515A0763-DE4D-E41 1-BE66-001636069930

| »

-

In the Highlight in window specify the line that is to be highlighted every time it appears in the message (1).

(FString 1\
Eeent S . § 8 F ] ot PO
1
LCusztomn colors:
.------- Hug:lw Bed:lﬁ
EEEEEENEN :
- | _PI _ §at:|m Green; |255
2 5 [efine Eugtonm Eolars &5 | ColarlSaid [z Blue; Iﬁ)
t QK b Cancel | r 4 Cancel | Addta Mistan Colors |

Click the Color button (2).

Select the color in the Color common dialog box (3).
Click the OK button(4).

Repeat steps 2-5 for all required lines.

Note.

To add a line to the table, click the key on the keyboard.
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7. Click the Yes button (5).

As a result messages with the specified line are highlighted in the Debug window.

il Debug window k|
Clear | Colors I Filter | [~ Apply filker Search |

React ; OPERATORPROTOCOL|1|DEACTIVATE|  slave_id<3-UYUTOMA, 1=, panel_ackive <=, user_jd= =
Ewent : DISPLAY|1|ACTIVATE|date <07-10-14: Fraction <326 >, uid_pk={8223C0DA-DD4D-E41 1-B666-001 636069930} =, owner <5-UVUTOYA >, panel_ai
! | React : MOMITOR |1 |ACTIVATE|  slave_id<S-YUTOMA = panel_active <0, user_id<=
React | SLAYE|S-UYUTOVA|DISPLAY CHAMNGE ACTIVE|display id<1=

E

B-D040-E411-E

React : MOMITOR|1|REMOVE_ALL|_ slave_id<S-LIYUTOMA >

React : MOMITOR|1|ADD|__slave_id<S-UYUTOWA >, arch_id <>, audio_id < >, sudio_type < >,cam <1 >,cam_zone_count <0, compression <=, compressor <
React : MOMITOR|1|ADD|_ slave id<S-UYUTOVA > arch_id <= audio_id<>,audio_bype <=, cam <2 >, cam_zone_count <03, compression <=, compressar <
React : MOMITOR|1|SETUP|43<0>,CAM, arch, 0< =, CAM, arch, 1 <=, CaM, arch, 2 < =, CaM, arch, count <3 =, CAM, cam.0<1 =, CAM.cam, 1 <2 =, CAM,cam, 2 <2

4| | »

The messages are now highlighted.
Event and reaction filter

The filter of events and reactions allows displaying only required messages in the Debug window.

To configure the filter of events and reactions, do the following:
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1. Click the

Filter button.

£

Clear | | Colors ( Filker )I_ Apply Filer Search |

Reack :
Event
Ewvent !
React :
React :

Event :
React :
Reack :
React :
Reack
Event
Ewent

al

OPERATORPROTOCOL| 1 |DEACTIVATE | slave_id<S-UYUTOVA. 1 = panel_ackive< = user_jd=>

CORE||DISPLAY CHAMGE _ACTIVE|dake<07-10-14 >, frackion =609, gui<l >,guid_pk={7E23C00A-D040-E41 1-B66-001636069930} =, owner <5
DISPLAY|1|ACTIVATE|date <07-10-14 > Frackion <328, quid_pk<{8223C00A-D040-E41 1-BE66-001 636069930 =, amner <S-UYUTOVA =, panel_a
MOMITOR |1 [ACTIVATE | slave id <S-UYUTOWA =, panel_active<0>,user_jd=>
5LF\'I.I'E|5 U'\"LITO'I.I'MDISF‘LA'\" CHANGE ACTI'I.I'E|E|IS|J|a'y' |E|<i1:='

A CODA-DD4D-E41 1-Bons-001¢

CF\MISIDET.ﬁ.CchDrE glu:ubal::l} date<07-10-14 =, fractll:ln{125>,guldjk{{DDSP.EuBEE -DD4D-E411-BE6A-0016360E69930} =, awner <S-LIYUTOWA
MOMITOR|1|REMOVE_ALL|  slave id<S-UYUTOWA=

MOMITOR|1[ADD] _slave_id<5-UvUTOYA =, arch_id< >, audio_id<>,audio_type<>,cam<1>,cam_zone_count=0>, COMpression < =, COMpressor <
MOMITOR |1 [ADD]_slave_id=<5-UYUTOYA =, arch_id <>, audio_id <=,audio_type< =, cam<2 =, cam_zone_count =0, cCompression < =, COMmpressor <

s MONITOR| 1| SETUP| 43 <0, CAM, arch, 0 <=, CAM. arch. 1 < =,CaM,arch. 2 <=, CAM, arch, count <3 =, CAM, cam, 0= 1 =, CAM, can, 1 <2 =, CAM, cam. 2 <
P MONITOR[1ACTIVATE _CAM|cam=1 = core_global<1 =,date <07-10-14=,fraction <828 =,quid_pk<{305a0763-DE4D-E41 1-BoA6-001636069930
: MOMITOR| 1| ACTIVATE_CAM|cam<1>,core_global<l > date <07-10-14 =, fraction <937 =,quid_pk<{815A0763-DE4D-E41 1-BE66-001636069930
-

| »

2. In the Filter window specify the lines that are to be in the message for it to be displayed in the Debug window (1).

Fiter x|

 Enable

|- - |
| llf_vent )
1
i - Exclude
: f Reack i
1
] 2
3
Co ) conee |
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3. Specify the lines that are to be in the message for it to not be displayed in the Debug window (2).

Note.

To add a line to the table, click the key on the keyboard.

4. Click the Yes button (3).
5. To apply the filter, set the Apply filter checkbox checked.

Clear | Calars | Filker Mv‘ &pply Filker ,. Search |

Ewvent

Event

Ewent

Event
1 SLAYE | S-UVUTOWA | IMITED| _TRAMSPORT _ID«<1111>,core_global<1>, core_slave_global <1 »,date<07-10-14 =, fraction <640 =,guid_pk<{35BE94
Ewvent :
Event :
Event :
Event
Event
Ewvent :
Event :
1 SLAYE|S-UVUTOVA |REGISTER_USER |dake <07-10-14 > frackion<515= quid_pk<{C1543479-DB40-E41 1-Ba66-001 636069930} =, omner <5-LYIITL
Event |
Event
1 SLANE |S-UVUITOWA |[EXECUTE _COMPLETE| _TRAMSPORT_ID<1111 >, command <video.run core|operatorprobocal.kun 1, core_global <1 >, date <07

P{ent :

SLAVE|S-UYUTOVA| CONMECTED|SOCKET <192, 168,0,2:, TRAMSPORT_ID<1111 >, TRAMSPORT_TYPE<SOCKET >, TRANSPORT_ID<>,care_glob

SLAYE |3-UYUTOWA|SET COMPRESSORS| _TRAMSPORT _ID<1111=,codecd<MIPEG=>,codecl <Mation Wavelet 3.5, codec? <Motion Meavelet 7,13

SLAVE[S-UYUTOWA|SET_DECOMPRESSORS| _TRAMSPORT _ID<1111 >, codecd <BOSCH >, codecl <FFmpegallndneDecoder =, codecld ::MF‘EG"rIpp[—

_SLAYE|S-UNUTOVA| COMMECTED |SOCKET <192, 168,02 >, TRANSPORT _ID <1050, TRANSPORT_TYPE<SOCKET =, TRANSPORT_ID <> core_glo
SLAVE |S-ILVUTOVA|DISC_EXIST|core_global=1 =, core_slave_global<1 »,date<07-10-14 =, fraction <562 =,guid_pk<{57866171-DB4D-E411-B66A-
CORE||D0_REACT|action=GET_TITLE_PARAMS = care_global<1 =, date <07-10-14=, fraction <796 =,guid_pk<{55566171-DE40-E41 1 -B666-0016]
SLAYE |3-YUTOWA|EXECUTE _COMPLETE| _TRAMSPORT_ID=1111»,command <video.run core|video.run core|audio. run| audio. runz,core_global <
DISPLAY|1 | ACTIVATE |date <07-10-14 =, Fraction <609 =, quid_pk<{C2543473-DE40-E411-B666-001636069330} =, owner <3-LUTOVA =, slave_id-

CORE||DISPLAY _CHAMNGE_ACTIVE|date <07-10-14 fraction<609=,0ui <1 >,quid_pk<{C3543A79-DE40-E41 1-BE66-001 636069930} =, owner <5-
TIME_ZOME| 1 |[DEACTIVATE|date <07-10-14 =, fraction <640 =, guid_pk<{C5543479-DE4D-E411-B666-001636069930) =, owner <5-LYLITOVA:, ki

SLAVEIS-UYUTOVAICONMECTED | SOCKET <192, 168.0, 2= TRANSPORT ID{IDD?}'.TRF\NSF‘ORT TYPE<SDCKET =, TRANSPORT ID{}.cDreikTLI
»

As a result only messages that fit the search criteria are displayed in the Debug window.

The event and reaction filter is now configured.
Searching for events and reactions

To search for events and reactions, do the following:
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1. Click the Search button (1). The Search window appears.

Debugwindow
Clear | Calors | Filter | I Apply Filker " 1

Reack
React
Reack

Event

Event
Event

l

Readk
: SLAYE|LADA|GET_COMPRESSORS|

| SLAYE|LADA|GET_DECOMPRESSORS)

! SLAVE |LADA|EXECUTE _SET|command <=, module_type <server > slave bvpe<l>
Event
| SLAVE |LADA|INITED|_TRAMSPORT_ID=1111,core_global«<1 =, core_slave_global <1 »,date <07-10-14 =, fraction< 156 ,quid_pk<{518D15EC-F14D-E411-B71
Event
| SLAVE|LADA|SET_DECOMPRESSORS|_TRAMSPORT ID<11113,codecl<BO50H:>, cod
1 SLAVE |LADA|EXECUTE _COMPLETE|_TRAMSPORT _ID<1111=,command=>

SLAYE |LADA|SETUR | COMMECTIONS, connection. count <05, COMNECTIONS, events. count <0, COMMECTIONS, guid. count <0, COMNECTIONS.ip_address, cour

SLAYE|LADA| CONNECTED|SOCKET <192, 165.0,4, TRANSPORT ID<11113, TRANSPORT TYPE<SOCKET >, TRAMSPORT ID<:core global<l:,date<0?-10

SLAYE|LADA|SET _COMPRESSORS| _TRAMSPORT_ID <1111 >,codecd <MIPEG »,codecl <Motion Wavelet 3.5 codecZ <Motion Wavelet 7.1 codec3<Mokion W

core_glob:
AYE|LADA|REGISTER LISER.|d: i GEEE:

3 ¢ M ateh whole word l:nnl_l,_l)I
4 {! Match caze) 5

2

6 2x

Find what: ‘ ,

Direction—————

)

" Up ™ Down

Cancel |

7

QUAWN

Note.

Specify the search criteria in the Search for: field (2).
If the specified string is to be searched as a whole word, not a part of any other word, then set the Match whole word checkbox checked (3).
If the search is to be case sensitive, then set the Case sensitive checkbox checked (4).
Set the Direction switch into the position corresponding to the search direction (5).

. To view the following search result, click the Find next button (6).

To close the Search window click the Cancel button.

The search for events and reactions is now complete.
Clearing the Debug window

To delete all messages from the Debug window, click the Clear button.




Debug window |
Colors | Filker | ¥ &pply Filker

Event : SLAVE|S-LYUTOWA|CONMECTED | S0CKET <192, 1658.0.2 =, TRANSPORT _ID<1111>, TRANSPORT _TYPE=SOCKET >, _TRANSPORT_ID <> core_alob
Ewvent : SLAVE|S-UYUTOWA|IMNITED|_TRAMNSPORT_ID=1111=,core_global<1=,core_slave_global <1 =, date<07-10-14 =, fraction <640 =,0uid_pk<{356E94
Event : SLAVE|S-UYUTOVA|SET_COMPRESSORS|_TRAMSPORT ID<1111>,codecd<MIPEG >, codecl <Mation Wavelet 3.5, codece <Motion \Wavelek 7.1: |
Event : SLAVE|S-UYUTOWA|SET_DECOMPRESSORS| _TRAMSPORT _ID<1111>,codec<B0SCH >, codecl <FFmpegallinOnebecodet =, codecl 0<MPEG4Ippl
Ewent : _SLAYE|S-UYLITOWA|CONNECTED|SOCKET <192, 168.0,2 =, TRANSPORT ID<1050%, TRANSPORT TYPE<SOCKET=, TRAMSPORT ID<=,core_glo
Ewvent : SLAVE|S-UYUTOWA|DISC_ERXIST|core_global<1 =, core_slave_global <1 =, date<07-10-14= Ffraction <562 =, quid_pk={57366171-DB40-E411-Baa6-
Event : CORE||DO_REACT|action<GET_TITLE_PARAMS> core_global<1> date<07-10-14 = fraction <796 >,quid_pk<{58566171-DE40-E411-B666-0016
Event : SLAVE|S-UYUTOWA|EXECUTE _COMPLETE| _TRAMSPORT_ID=1111>,command<videa run core|video,run core|audio.run|audio.run =, core_global <
Ewent : DISPLAY|1|ACTIVATE [date <07-10-14= fraction <609 >, quid_pk<{C2543479-DE40-E41 1-BE66-001636069930 =, owner <S-UYUTOYA S slave_id:
Event : SLAVE|S-UYUTOMA|REGISTER _UISER, |date <07-10-14=,Fraction <515 =, quid_pk<{C1543470-DB40-E41 1-BA6E-001636069930} =, owner <S5-LY LTt
Event : CORE||DISPLAY CHANGE ACTIVE|date<07-10-14> Fraction<609:,qui=1>, quid_pk={C3543479-DB40-E41 1-B666-001636069930 =, awner <5
Event : TIME_ZOMNE|1|DEACTIVMATE |date <07-10-14 =, fraction<640>, quid_pk={ 5543473-DB40-E41 1-BAEE-001 636069930} >, omner <S-LVUTOWA =, ki
Ewvent : SLAVE|S-UYUTOWA|EXECUTE _COMPLETE| _TRANSPORT_ID=<1111=,command = idea.run core|operatarprotocal, run 1=, care_global <1 =, dake<07%
ﬂent: SLAVE SV UTOVAICOMMNECTEDISOCKET <192, 1680, 2 =, TRANSPORT IDilDD?}.TRANSPORT TYPE=<SOCKET =, TRAMNSPORT ID::.‘#.mreﬁll

Getting the list of object names, reactions and events in INTELLECT™

The list of object names, reactions and events used while programming in INTELLECT™ software can be got with the help of ddi.exe tool.
ddi.exe tool is started in one of the following ways:

1. “Start All Programs Intellect Tools System configuration.

Note

ddi.exe tool is available in the Start menu with the following types of Intellect installation: Server, Administrator’s workplace and Workplace for monitoring

2. In the Tools folder of Intellect installation folder.
To view the list of object names, events and reactions, do the following:

1. In the tool, open intellect.ddi file.
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2. Select the DDI tab on the left (1). The list of system objects is displayed here.

%+ DDI & DBI Editor =10l x|
3
2 (Names: Eventsl Heactionsl Label&l State&l Tranzition rulesl

T ¥F ECTIVER -

{Q ARCH \ M arne
.3 ARCHIVER |
- ARCHRANEL
- ATM Group name
P ATM25 CLIENT |
- ATM¥25_SERVER
- ATH_ITY Search by name
- CAM Ic:am
- CamM_FACECAPTURE
- CaM_IP_DETECTOR |— Object Mame
- CAM_TITLE Céibd Camera
- CAM_VMDA Cam_FACECAPTURE Face capture camera
¢ CaM WMDA DETECT Cak_IP_DETECTOR Embedded detector

¥ CaM_vMDA_
. CapM_ZONE CAM_TITLE Titles database
- COMFIG Cakd_WMDA Tracker
99 DEPARTMENT Cam_VMDa_DETECTOR Dretector

V e CAM_ZOMNE Detection zone
- DISFLAY
.49 DMD
- DRS
4% EVENT_COUNMTER
- EVENT_WIEWER
. GATE
-4 GRABBER
- GRAY

\.- ¥ GRELE JE

1| [ »

[Obgects in tokal :72 4

3. In the DDI tab, select the object which events and reactions are to be viewed (2).

4. To view the name of the selected object, go to the Names tab (3).
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5. To view the list of events for the selected object, go to the Events tab.

f,- DDI & DBI Editor - [C:\Program Files\MuTennexkt\Languages\en\intellect.ddi]
File

ool |oai |

=1oix|

ACTIVEX
ARCH
ARCHIVER
ARCHPANEL »
ATM
ATMX25_CLIENT |
ATMX25_SERVER
ATM_ITV —
CAM
CAM_FACECAPTURE
CAM_IP_DETECTOR P
CAM_TITLE
CAM VMDA —_
CAM_VMDA_DETECTOR
CAM_ZONE

CONFIG L
DEPARTMENT
DIALOG o
DISPLAY
DMD =
DRS
EVENT_COUNTER
EVENT_VIEWER =
GATE | |
GRABBER =
GRAY
GRELE
HTTP —
KEYB
LEVEL —
LMCFTP
LMCGATE
MACRO

|»
=
o
- |
o
4 =
[=]
3

Connection emor

‘ Support audio

Disable network

S Disable logging

Windows log

CONNECT_FAIL
MAIL_MESSAGE CONNECT_OK Connected
MAIN

MAP METWORK_FAIL... |Connection lost

m:lﬁ IﬁAL;-ErEOH M STATE_CONNEC... |Connection restored

ESSAGE *

Elimhsiinlinis B B B RN

mimiiniinin e e
misiis i
mimiin i e e

MMIS
MONITOR =

Total objects: 70




6. To view the list of reactions for the selected object, go to the Reactions tab.
1:- DDI & DBI Editor - [C:\Program Files\Murennexkr\Languages\en\intellect.ddi] i = |EI|5|

File

DDI | DEI I Names I E\rerrts(RBEdi"”S}Imns I States I Transition rules I

| v

ACTIVEX Reaction | Description Aming
ARCH : 2

ARCHIVER 3 Disable video output 1

| ﬁ-ﬁrﬁHPAN EL MUX2_OFF Disable video output 2

ATMX25_CLIENT MUX3_OFF Disable video output 3
ATMX25_SERVER
ATM_ITV *
CAM

CAM_FACECAPTURE

CAM_IP_DETECTOR

CAM_TITLE

CAM_VMDA

CAM_VMDA_DETECTOR

CAM_ZONE

CONFIG

DEPARTMENT

DIALOG

DISPLAY

DMD

DRS

EVENT_COUNTER

EVENT_VIEWER

GATE |
GRABBER

miimlimiin

GRAY
GRELE

| LS

KEYE Parameter MName Type Element | Value

g
|

s of action "Disable video output 1:

LEVEL *
LMCFTF

LMCGATE

MACRO

MAIL_MESSAGE

MAIN

MAP

MAPLAYER

MAPPLATFORM

MESSAGE

MMS

MONITOR LI

Total objects: 70

The detailed information on working with ddi.exe tool is given in Administrator's guide.

Note.

If the Sensor is armed, then at the Sensor switching on/off the "Alarm" event appears depending on the alarm mode setting (see the Creating and configuring the Sensor
system object section of the Installing and configuring security system components guide). If the Sensor is disarmed, the "Closed" / "Opened" events appear correspondingly.

Operations with scripts

Creating a script


https://doc.axxonsoft.com/confluence/pages/createpage.action?spaceKey=Int411en&title=Administrator%E2%80%99s+Guide&linkCreation=true&fromPageId=136250405
https://doc.axxonsoft.com/confluence/display/Int411en/Creating+and+configuring+the+Sensor+system+object
https://doc.axxonsoft.com/confluence/display/Int411en/Creating+and+configuring+the+Sensor+system+object
https://doc.axxonsoft.com/confluence/display/Int411en/Installing+and+configuring+security+system+components+guide
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To create a JScript script in Intellect, the Editor-Debugger utility is used.

To start the utility, click the Editor-Debugger button in the Script object settings panel.

To create a script, do the following:

1.
2.

In the Programming tab of the System Settings window, create a Script object. Enter the identification number and the name for the script.
Select the time limits for running the script in the Time Zone field (for example, the Always zone).

Note

By default, the Never time zone is selected

. In the Computers field, select the computers (kernels) where the script should run.

Note

By default, the script will run on all computers. The list shows only the computers registered in the Hardware tab of the System Settings window

. Click the Editor-Debugger button in the bottom of the Script settings panel to open the Editor-Debugger utility.

Note

Use the Editor-Debugger utility to create, edit and save scripts in JScript. The text of saved script available to be edited is saved on the setting panel of the Script
object.

. In the Editor-Debugger utility window, open the Script Debug/Edit list and select the Script object to be edited (for example, Script 2).



Gsrniz-ee L=

File “iew Debugand edit List of events Help

»EBEHDS | 2msTF T
[ Script Messages —Script
[=- Script Debug/Edit

- Sript 1

—Event

" o

Ready ’_ W A

6. Enter the text of the script in JScript programming language into the Script field.



7. Run the script using a test event. To create a test event, select the Edit test event in the Debug and edit menu. The Test message window will open allowing to set the test
event parameters.

e — -0l x|

File iew Debugand edit  List of events  Help

PEHARE| 2T T
- Sctipt Messages Script
[l Script Debug/Edit

o~ Seripk 1

i Srripk 2

Testmessage x

—SourceType
| MACRO

—Sourceld
| 1
— SourceAction
| RUM

param | walue

Yes Cancel ;I

Ready ’_ W A

8. To run the script using the test event, select Test run in the Debug and Edit menu.

Note.

Also, use Ctrl+T hotkey to test-run the script by test event.
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9. Check the script syntax using the interpreter which is built-in into the Editor-Debugger utility. The verification results showing the error and its location will be displayed in the
debugger window of this script in the Script messages list. Correct the script to eliminate the error and repeat the verification.

Note

See the detailed information about using test events for script debugging in the Script Debugging section

10. After debugging the script using the Editor-Debugger utility, run it with a real event. Check the result. If the result is incorrect, change it and run again.

Script creation is considered complete if it runs correctly.

Saving a script
The Editor-Debugger utility provides two options for saving scripts — in a Script object, or in a text file on the hard drive.

To save the script in the Script object, in the File menu, select Save in the database.

Note.

Also, use Ctrl+S hotkey to save the script in the database.

Note

The script is automatically saved in the corresponding Script object upon closing the Editor-Debugger utility

To save the script in the file, in the File menu, select Save on disk. To open a script saved in a file in the Editor-Debugger utility, in the File menu, select Open from disk.

Deleting a script

To delete a script created in the Intellect system, delete the corresponding Script object in the Programming tab.

Search text in script

The Editor-Debugger allows searching text in script using a dialog box.

Press Ctrl+F to open search dialog box. The Find dialog box opens.



P 1

Find

Find what: | 1

2_ Match whole word onby Direction Cancel

3_ Match case f Up  Down

4

Enter the text to find in the Find what: field (1).

Set the Match whole word only checkbox to search for the text in whole (2).

Set the Match case checkbox to case-sensitive search for the text (3).

Select the direction of search through the text relatively to the current cursor position: Up (4) or Down (5).
Click Find Next to run search or go to the next entry (6).

Click Cancel to stop search and close the dialog box.

il

I S

The found match is highlighted in the Editor-Debugger utility window.

Secript
if (Event.SourceType == "PEQPLE COUNTER" && Event.Sourceld == "N" &&
@ Itv_var("counter i"):
= Itv _wvar("counter k"):
i++;
Itv var ("counter i"}=i:;
Find
Find what: i Find Next
v Match whole word only Direction Cancel
~ S
[ Match case Llp i

Replace text in script

The Editor-Debugger allows replacing text in script using a dialog box.

Press Ctrl+H to open replace dialog box. The Replace dialog box opens.
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P

Replace @

Find what: | 1
Replace with: | 2
3_ Match whole ward only
Cancel
4_ Match case
1. Enter the text to find in the Find what: field (1).
2. Enter the text to replace the found text with in the Replace with: field (2).
3. Set the Match whole word only checkbox to search for the text in whole (3).
4. Set the Match case checkbox to case-sensitive search for the text (4).
5. Click Find Next to run search or go to the next entry (5).

Note.
The search runs down from the current cursor position.
6. Click Replace to replace the current found match (6).

Click Replace All to replace all matches automatically (7).
8. Click Cancel to stop close the replace dialog box (8).

N

Example of use fo replacing variable i to s:



1. Before replacement:

Script
if (Event.SourceType == "PEOPFLE COUNTER" &£& Event.Sourceld == "N" &&
= {
I = Ity var("counter i"):
k = Itv _var("counter_k");
it++;

Itv var("counter i")=i;

Replace
Find what: | Find Next
Replace with: |s| Replace
Replace Al
v Match whole word anly
Cancel
[ Match case
2. After replacement:
Script
if (Event.SourceType == "PEOPLE COUNTER" && Event.Sourceld == "N" &&
=
s = Itv var("counter i");
k = Itv wvar ("counter k");:

S++;
Itv_var ("counter i")=as;

Replace
Find what: i Find Next
Replace with: |s Beplace

¥ Match whole word only

Cancel
[~ Match case 4

Creating your first script

As an example of using JScript in Intellect, try to create a script for the following tasks: when Macro 1 starts, set the value 10 to the Hot Recording parameter for Cameras N° 1 - 4
and output the Hello world message to the debugger window of the Editor-Debugger utility.

To create and run this script, do the following:
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In the Hardware tab of the System Settings window, create four Camera objects with identification numbers 1, 2, 3 and 4, if they have not been created before.

In the Programming tab, create a Macro object with identification number 1. The Events table should not be filled for .

Create a Script object in the Programming tab. Enter the identification number 1 and the name Script 1.

In the Script 1 object settings panel, select Always in the Time zone list.

Click the Editor-Debugger button at the bottom of the Script 1 settings panel. The Editor-Debugger window will open.

In the Editor-Debugger window, open the Script Debug/Edit list and select the Script 2 object.

Fsoitz-ExE =lol x|
Flle Wiew Debugand edit Lisk of events  Help
»EHRE | cwsF P

[#- 5cript Messages —Scripe

ounhkwne

4| ||
—Event
-
o of
Ready ’_’m’— P
7. Enter the following in the Script field:
if (Event. SourceType == "MACRO' && Event. Sourceld == "1" &&
Event . Action == "RUN'")
{
var ;
for(i=1; i<=4; i=i+l)
{
Set Cbj ect Param("CAM', i, "hot _rec_tine","10");
}



. DebugLogString ("Hello world");
-} i

8. In the File menu, select Save to database to save the script.
9. Create a test event to run the script in debug mode - "MACRO|1|RUN|”. To achieve this, in the Debug and edit menu, select Edit test event; the Test message window will
open. Fill in the fields in the Test message window as shown in figure.
Soper e = 1=k
File iew Debugand edit  List of events  Help
PEHRE 2w sT T
- Sctipt Messages Script
[l Script Debug/Edit
o~ Seripk 1
i Srripk 2

Testmessage x

—SourceType
| MACRO

—Sourceld
| 1
— SourceAction
| RUM

param | walue

Yes Cancel ;I

Ready ’_ W A



10. To run the script with the test event, select Test run in the Debug and edit menu.

11. Open the Script Messages list and select Script 1. The debugger window will open at the right side.

12. In the debugger window, find the “Process Event:MACRO|1|RUN|” line and the following error message: “Src identifier missing: Microsoft JScript compilation error Line:2 Char:6
Error:0 Scode:800a03f2".

Gseptt-e =lo(x|

File Wiew Debug and edit  List of events  Help

PELHPE R L s S P

E| S_cript Messages Drescripkion |
© - Script 1 Process Event:SCRIPT|1|SETUP|int_obj_id<1>,SLAVE.slave_id.count <0, flags <=, par
Scripk 2 Expected YO OSrc: Micrasaft JScript compilation error 0 OLing:2 Char:17 Errar:0 Scod
[ Script Debug/Edit End ProcessScript, begin-end delay: 74 [msec]

Process Event:SLAYE|E-RYAZANOWA|REGISTER_USER |int_obj_id<1 =, owner <E-R¥AZA
Expected 'O 0OS5rc: Micrasoft IScript compilation error 0 OLine:2 Char:17 Errari0 Scod
End Pracessscript, beqgin-end delay: 0 [msec]

Process Event:SLAYE|E-RYAZANOWA | CONNECTED|ink_obj_id<1>,SOCKET<10.0,1,.50 =
Expected 'O 0OS5rc: Micrasoft IScript compilation error 0 OLine:2 Char:17 Errari0 Scod
End PracessScript, beqgin-end delay: 74 [msec]

Pracess Event:SLAYE|E-RYAZANOYA|EXECUTE_COMPLETE|int_obj_id<1 > slave_id<E-F
Expected 'O OSrc: Micrasoft IScript compilation error 0 OLine:2 Char:17 Errari0 Scod
End PracessScript, beqgin-end delay: 1 [msec]

Process Event:SCRIPT|1|SETUP|int_obj_id<1>,SLAVE.slave_id.count <0, flags <=, par
Expected 'O OSrc: Micrasoft IScript compilation error 0 OLine:2 Char:17 Errari0 Scod
End PracessScript, beqgin-end delay: 2 [msec]

Process Event:SCRIPT|1|SETUP|int_obi_id<1>,SLAVE.slave_id.count <0, flags <=, par
Expected V'O 0OSrc: Micrasoft Script compilation error 0 OLine:2 Char:17 Errari0 Scod
End PracessScript, beqgin-end delay: 1 [msec]

Process Event:MACRO[1JRUMrest <1 >, b2 5] ||

Expected 'O DSrc M|crosoft JScrlpt compilation error 0 0OLine: 2 Char: 17 Ervar:0 Scod

Seripk 1
- SCHpE 2

11
Process Ewent:SCRIPT|1|SETUP|int_obj_id<1=,5LAVE.slave_id.count <0= Flags <=, par
Expected YO OSrc: Microsoft J5cript compilation error 0 OLine:2 Char: 17 Error:0 Scod
End ProcessScript, begin-end delay: 1 [msec]

P M 4

The error message says that there is no identifier in the second line of variable declaration operator (var). That means no variable has been declared. This is a critical error in
JScript, thus the script has not been executed.
13. Change the text of the script (see the “var i;” line).

{
Set Obj ect Param("CAM', i ,"hot _rec_tine","10");

if (Event. SourceType == "MACRO' && Event. Sourceld &&
Event. Action == "RUN') i
(
for(i=1: i<=4; i=i+l)

i var i



}
DebuglLogString ("Hello world");

—

14. In the File menu, select Save to database to save the script.

15. Repeat steps 10 and 11.

16. In the debugger window, find the “Process Event:MACRO|1|RUN|” line and the “DebuglLogString:Hello world” and “Script first run OK” messages. The “Script first run OK”
means that the script runs correctly in the debug mode.

Ssepti-BE =lolx|

File Wiew Debugandedit List of events Help

PEHBE[ 28 e Y P

[=- 5cript Messages Description ;l
. --Seript 1 Expected YO OSrc: Microsoft J5cript compilation error00OLine: 2 Char:17 Error:d Se
Seripk 2 End ProcessScript, begin-end delay: 1 [msec]

[ Seript Debug/Edit Process Event:MACRO[LJRUMtest <1 = b2 ||

: Seript 1 Expected WO OSrc: Microsoft J5cript compilation error O 0OLine: 2 Char: 17 Error:0 3¢
L. Seript 2 End ProcessScript, begin-end delay: 13861 [msec]

Process Event:MACRO[1JRUMest <1 >, t<2 =) ||

Expected WO OSrc: Microsoft J5cript compilation error 0 0OLine: 2 Char: 17 Error:0 3¢
End ProcessScript, begin-end delay: 1 [msec]

Process Event:SCRIPT|1|SETUR|ink_obj_id<1=,3LAVE.slave_id.count <0:=,fags <=,
Expected 'O 0OSrc: Microsoft J5cript compilation error 0 OLine: 2 Char: 17 Errar:0 5o
End Processacript, begin-end delay: 1 [msec]

Process Event:SCRIPT|1|SETUR|ink_obj_id<1=,3LAVE.slave_id.count <0:=,fags < =,
Expected identifier 0 O Src: Microsoft 15cripk compilation error O OLinesZ Char:é Errc
End Processacript, begin-end delay: 1 [msec]

Process Event:SCRIPT|1|SETUR|ink_obj_id<1=,3LAVE.slave_id.count <0:=,fags < =,
Expected identifier O O Src: Microsoft 15cripk compilation error O OLinesZ Char:é Errc
End Processacript, begin-end delay: 1 [msec]

Process Event:MACRO[1TRURM| ||

Expected identifier O O Src: Microsoft 15cripk compilation error O OLinesZ Char:é Errc
End Processacript, begin-end delay: 2 [msec]

Process Event:SCRIPT|1|SETUR|ink_obj_id<1=,3LAVE.slave_id.count <0, fags <=,
Expected identifier O O Src: Microsoft 15cripk compilation error O OLinesZ Char:é Errc
End Processacript, begin-end delay: 1 [msec]

W Process Event:MACRO[TJRURM]||

b 2 E=
Process Event:SCRIPT|1|SETUP|int_obi_id<1>,5LAVE.slave_id.count <0, Flags <>,
Seripk first run QK
End PracessScript, beqgin-end delay: 1 [msec] —

4| | _'l;
[ [

17. Close the Editor-Debugger utility.
18. The text of the created script will be shown in the Script field of the Script 1 object settings panel. Click the Apply button in the Script 1 settings panel to activate the script.
19. Select Macro 1 in the Run menu of the main control panel.
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20. In the debugger window of the Intellect system, check that the macro and the script have run successfully.

E

Feact :
React
Ewent :
Ewent :

LLvent

MOMITOR SET_MARKRECT operator<: cam<1> wpedCORMER: id<5> w1205 #1¢ 3 02436 colorg 167772150 m2cd 4

MOMITOR 1 SET_MARKRECT operatar<> cam<1s _ slave_id<[-YARODSLAVOV: tope<4CORMNER: id<5 w1205 #1<31x p2< 363 calars
CORE DO_REALCT int_obi_id< 1 slave_id<|-YAROSLAYDY > paramy_name<=2» paramb_name<=1: paraml_wal:1: param3_name<y2s |
E.-'i‘-.M 3 HEE STOF int_ob_id<1> zlave_id<|"AROSLANVOY: core_global<1: owmner<| kr’.-ﬁ-.FH:ISL.-'i‘-."-u-"I:I"-.-"> tlme<'|2 I:I4 2EI> date<29 04-08

TTOF it ohi jds1 slavs d; LSRG AVES sore B 3-04-08>
MACED 1 BUM int obj id<1: core globals1: user id<: ownerdl-vAaB0SLAVDY > tlme<12 EI4 22> date<2E| [14- EIE>

Ewent :

PMUMNITUR T ALTIVATE _CAM int_ob|_1d< 1> slave_1d<[-vY ARUSLAYLN core_global T cam< T ownerd]-r ARLS LAV brme<12:04:42

21. Check the accuracy of the script result. The Hot recording field in the Camera 1 to Camera 4 object settings panels should read “10".

I

Videa

Region | ¥

Type:

i

ICamera 1

apture Dewice [ Disable

Video Capture Device 1 j

¥ Brightness  Contrast
Drecoder number |U *I man . r . . |_ ; I _I
Rezolution |Standard 'I ~Recording audio——————
~ Recarding quality T I : = I = IMicmphone‘I j
— -
b ' ! : ' [~ Sensitivity Pre-alam record I 5
mir Tax

r Decompreszor

[~ Colar |_J— . E.I_IE ;1_I§ @Dtrecord"time 10 3
mn | = Pt

I- YL 22 I. ......... i
]

max = r 2 El_ = Post-alarm record 3

"Hot record" rate ::I fps

Folder |D:\SaftDiopbos'i | [ Recard alams

Basic settings I Advanced zettings |

Size Contrast Recording frame rate 3: fps

Apply Cancel

Note

The Hot recording field in the Camera settings panel is empty by default

Script creation

and debugging is now complete.

Script debugging
Script debugging features



The Editor-Debugger utility allows debugging scripts using the built-in tools for checking script syntax, script interpreting and script execution with test events generated by the utility.
The messages about the debugging results are displayed in the corresponding debugger windows.

The Editor-Debugger utility provides the following debugging functionality:

A separate debugger window is assigned to each Script object, where the test and system events, error messages, success messages and user information messages are

displayed. The messages in the debugger windows can be filtered.
2. Special Information window debugger windows are available for displaying the messages related to the script being debugged.
3. Test events generated by the Editor-Debugger utility, which are not registered by the Intellect system, are used for checking script accuracy.

4. Third-party debugger programs can be used for step-by-step execution, viewing script variables during execution, and other functionality.

1.

Creating and using test events
Creating test events

The Editor-Debugger utility is capable of generating test events chosen by the user to help debug the scripts. Test events are not registered by the video surveillance system, i. e. they
are not listed in the events log and not saved to the database.

No more than one test event can be created for each script.

To create a test event, do the following:

1. In the Debug and edit menu, select Edit test event, or click the button in the toolbar.
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2. The Test message window will open.

[(Fsorib1-EE =10l x|
File ‘Wiews Debugand edit  Lisk of events  Help
»EHRE | 2mpF T
-- Script Messages Seripk
[l Seript Debug/Edit
i~ Seripk 1
Lo Seripk 2
x
—SourceType
IMACRO
Sourceld
|1
r— Sourcedction
IRUN
parar | walle
I~
Yes Canicel ;I
-
5 »
Ready [ o[

This window is used for entering the test event parameters.

3. Enter the following information in the fields of the Test message window:

SourceType - object type;

u b WN =

Sourceld - object identification number;
SourceAction - the event generated by the specified object;
param - additional event parameters;
value - values of the additional parameters.
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4. Click the OK button.

The test event is now created.
The created test event will be displayed in the Event field in a special string format.

Figure shows the test event example: "Arm Camera 111”.

Ssciprz-Bxe =lolx|

File ‘iew Debugandedit List of events Help

»>EMRE|2mgF P

[l Seript Messages [~ Script
o eScript 1 if (Event.SourceType == "MACRO" &£& Event.SourcelId && Event.Action == "]
Script 2 1
- Seript Debug/Edit Gar i
i~ Seript 1 for{i=1; i<=4; i=i+1]
o Seripk 2 i

SetDbjectParam|"CAM", i, "hot_rec time","10"):
}
DebugLogString ("Hello world™):

< | 2
—Event
(CaM[L][ARM] <) =]
Kl _'I_I
Icap [ 4

Running the script with a test event

To run the script with a test event, do one of the following:

1. Click the Test run ( = ) button in the toolbar.
2. In the Debug and edit menu, select Test run.
3. In the Debug and edit menu, select Test run in third-party debugger.



When the Test run in third-party debugger option is selected, the third-party debugger starts to run the test (see details in the Using third-party debuggers section).
The results of the verification and execution of the script are displayed in the corresponding debugger window of the Editor-Debugger utility.

Using debugger windows of the Editor-Debugger utility

Debugger window types: Script Messages and Thread Information

Debugger windows display messages about system and test events, errors and successful script execution, as well as user information messages.

A separate debugger window is assigned to each script in the Editor-Debugger utility.

There are two types of debugger windows: Script Messages and Thread Information.
The names of Script Messages windows are listed in the Script Messages list. The names of the windows match the names of the corresponding Script objects. These windows display

all system messages related to all scripts in the Intellect system.

&% script 1 - EXE _1o x|
File Wiew Debugandedit List of events Help
PEIHRSE|2m i P P
E| S_cript Messages | rScript
seript 1 I Information from stream il == ]
i e Seripk 2
[=- Seript Debug/Edit SRR
L. Seripk 1 Process Event:MACRO[1JRURM| ||

: 3 Script first run Ok
----- Script 2
gk End ProcessScript, begin-end delay: 1 [msec]

Ready
E— T
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The Thread Information windows open directly from the script editing windows (named in the Script Debug/Edit list). To open the Thread Information window from an active script

editing window, select Summary information in the Debug and edit menu, or click the button in the toolbar. The Thread Information windows display only the events related to
the current script being debugged.
(=]
File Wiew Debugandedi List of events  Help
»EBHRE 2@ e T T
[l Seript Messages | rSCfiDt
: = Seripk 2 —~
[=- Seript Debug/Edit I=ERERE
Seript 1 Process Event:MACRO[1JRUR|||
Seript 2 Script first run OK
End ProcessScript, beain-end delay: 1 [msec]
2
;I_I
Ready 4
I |+ .

Both types of debugging windows are used in the same way.
Displaying messages about starting, verifying, changing and executing scripts in the debugger windows

The messages in the debugger window track the stages of starting, verification and execution of scripts.

When the event occurs that triggers the script, the following message is displayed in the debugger window: “Process Event: <script triggering event>"; for example, if the script starts
upon Macro 1 execution, the line reads “Process Event:MACRO|1|RUN]|".

At the moment of changing the script in Debugger utility or in the Intellect, the debugger window displays the message «Process Event: SCRIPT|script’s number|SETUP|» (for example,
while changing the script with number 1, the debugger window displays «Process Event: SCRIPT|1|SETUP|»).



Script syntax is checked before execution. In case of syntax errors, related error messages will be displayed in the debugger window. Figure shows an example of a syntax error

message.

(Gsoips-exe ~lofx|

File Wiew Debugandedit List of events Help
»EHBE| 28 Y P

EI S_cript Messages Description

+- Seripk 1 P E L
Expected identifier OO Src: Microsoft JScript compilation error 0 OLine: 2 Char:6 Error:0 Scode:BDDa@

- Scripk 2
Script 3 End ﬁrocessgcnpf, Eegln-ena GE 3y 1 [msec |

[} Script Debug/Edit
L Serip 1
- Scripk 2
----- Scripk 3

| 2
cap um [

4]

Right-click the message to view its complete text. The Information window will open containing the full text of the error message.
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The message contains the following information:

1. Error description;

2. Error type (for example, Src: Microsoft Jscript compilation error);

3. Error location in the script text (line number and character number in the line);
4. Error code (Scode).

In case no errors were detected, the following message will be displayed in the debugger window: Script first run OK. Then, the script will run.
Script runtime errors are also displayed in the debugger window.

In case of successful execution of the script, the following message will be displayed: “End ProcessScript, begin-end delay: <script execution time>; for example, “End ProcessScript,
begin-end delay: 13 [msec]”.

Using third-party debugger programs
The Intellect software package officially supports debugger Microsoft Visual Studio 2005.
The Intellect software package allows using third-party debuggers for processing JScript scripts. These programs may have the functionality that is not included in the Editor-Debugger
utility, for example, step-by-step script execution, watching script variables during script execution, etc.
Note
We do not recommend using third-party debuggers, since they do not provide full compatibility with the Intellect software, and may lead to failure of the Intellect software

We strongly recommend introducing the breakpoint in the script when using third-party debuggers. To insert the breakpoint, add the following line to the script: “debugger;”. The
script execution will pause at this line, and the debugger will start.
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When a third-party debugger is used, scripts can be started with test events only.
To start the script using a third-party debugger, do the following:

Create the script and insert the “debugger;” line in it.

Create a test event for the script.

In the Debug and edit menu, select Test run in third-party debugger.

The Just-In-Time Debugging window will open. Select one of the debuggers installed on the computer.

Just-In-Time Debugging

AWNR

Please select a debugger.

Possible Debuggers;

Mew instance of Microsoft Script Editor

[ Zet the currently selected debugger as the default,

Do you want ko debug using the selected debugger?

Yes Mo |

5. Click Yes to confirm the selection.

In case of a successful syntax check (no errors found before the “debugger;” line), the third-party debugger will start. The script will pause at the breakpoint.

Example. A script with the use of the breakpoint when Macro 1 starts.

i f (Event. SourceType== "MACRO' && Event. Sourcel d=="1" && Event.Action == "RUN"); //start Macro 1

{
debugger; // breakpoint

DebuglLogString ("Hello world");



85

Examples of scripts in JScript language

On the page:

® Example 1. Visualisation of operating the
Queue length detection in the Video
Surveillance monitor

® Example 2. Visualisation of operating the
People Counter detection in the Video
Surveillance monitor

® Example 3. Setting the text for displaying
on the map

® Example 4. Displaying camera on the
monitor by clicking the button on the
remote control

® Example 5. Sending command to camera
using the camera HTTPAPI

® Example 6. Script for framing abandoned
objects in live video

® Example 7. Using START and STOP events
for Failove

To illustrate available fields of application of scripts in Jscript see the following examples which can be used to create additional functions in the system on the basis of the Script
object.

Example 1. Visualisation of operating the Queue length detection in the Video Surveillance monitor

The Queue length detection object (is part of the Detector Pack package), Camera and Captioner objects (instead of N, M, L symbols set the corresponding numbers of the Queue
length detection, Camera and Captioner objects) are to be created and configured for correct script working in the Intellect software.

/| Event reading by the queue length
if (Event. SourceType == "OCCUPANCY_COUNTER' && Event. Sourceld == "N' && Event. Action == "OCCUPANCY") //N -
Nunber of Queue | ength detection
{
var n=EBEvent. Get Par an{"occupancy");
/1 Di splayi ng the queue nunber by the Captioner in the Mnitor
DoReact Str("CAM', "M', "CLEAR SUBTI TLES","title_id<L>"); //M- Nunber of Canmera L - Nunber of Captioner
DoReact Str (" CAM', "M, "ADD_SUBTI TLES", "command<Queue | ength: "+n+" person(s).\r>, page<BEA N>, title_ id<L>");
/[I'M L - the sane

}



As a result the text message about the current queue length will be imposed on the video image while displaying the corresponding camera in the Video Surveillance monitor.

Settings of the font, color and position of text is configured on the settings panel of the Captioner object.

Example 2. Visualisation of operating the People Counter detection in the Video Surveillance monitor

The People Counter Detection object (is part of the Detector Pack package), Camera, Captioner and Macro objects (instead of N, M, L, P symbols set the corresponding numbers
of the People counter detection, Camera, Captioner and Macro objects) are to be created and configured for correct script working in the Intellect software.

/I Event reading and counting of entered people
i f (Event. SourceType == "PEOPLE_COUNTER' && Event. Sourceld == "N' && Event.Action == "IN') //N - Nunber of
Peopl e Counter detection
{
Itv_var("counter_i");
Itv_var("counter_k");

i
k
i ++;
Itv_var("counter_i")=i;

/1 Di splaying the nunber of people by Captioner in the Mnitor

DoReact Str (" CAM', "M', " CLEAR_SUBTI TLES","title_id<L>"); //M- Nunber of Camera L - Nunber of Captioner
DoReact Str (" CAM', "M', "ADD _SUBTI TLES", "comand<Nurber of people (entering/exiting): "+i+" [/ "+k+"\r>,
page<BEG N>, title_id<L>"); //M L - the sane

}
/I Event readi ng and counting of exitng people
if (Event. SourceType == "PEOPLE_COUNTER' && Event. Sourceld == "N' && Event.Action == "OUT") //N - Nunber of
Peopl e Counter detection

{

i
k
k++;
Itv_var("counter_ k")=k;

/1 Di splayi ng the nunber of people by Captioner in the Mnitor

Itv_var("counter i");
Itv_var("counter k");

DoReact Str (" CAM', "M', "CLEAR SUBTI TLES","title_id<L>"); //M- Nunber of Camera L - Nunber of Captioner
DoReact Str (" CAM', "M', "ADD_SUBTI TLES", "command<Nurber of people (entering/exiting): "+i+" [/ "+k+"\r>,
page<BEGA N>, title_id<L>"); //M L - the sane
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}

/I Nul'l the counter by Macro (previously the Macro is to be created in the Intellect)

if (Event. SourceType == "MACRO' && Event. Sourceld == "P" && Event.Action == "RUN') //P - Nunber of Macro
{
Itv_var("counter i")=0;
Itv_var("counter_k")=0;
i =0;
k=0;

/1 Di spl ayi ng nunber of people by Captioner in the Monitor

DoReact Str (" CAM', "M', " CLEAR_SUBTI TLES","title_id<L>"); //M- Nunber of Camera L - Nunber of Captioner
DoReact Str (" CAM', "M', "ADD_SUBTI TLES", "comand<Nurber of people (entering/exiting): "+i+" [/ "+k+"\r>,
page<BEG N>, title_ id<L>"); //M L - the sane
}

As a result the text message about number of entering and exiting people will be imposed on the video image while displaying the corresponding camera in the Video Surveillance
monitor.

Settings of the font, color and position of text is configured on the settings panel of the Captioner object (see the Configuring captions display on a video image section of the Administ
rator’s Guide document).

Previously create the Macro object on the Programming tab to null the counter of visitors. The name of the object can be changed to “Null of people counter” for ease of using.

Macro of setting to zero can be run manually by main menu of the Intellect software package or automatically in any specified time (use the Events table on the settings panel of the M
acro object where the previously configured Time zone object is to be specified). Detailed information about using the Macro and Time zone objects is given in the Administrator's
Guide document).

Example 3. Setting the text for displaying on the map

It is possible to select the type of Text displaying while attaching object to the map (see Administrator Guide, the Attaching objects to the layers of interactive map section). Also the
script on the JScript language can be used for changing the displayed text.

Example. The Text type of display on the map is selected for the Camera 1. It's required to display value of the MyVar value read from the C:\test.ini file on the map and debug
window while processing the Macro 1.

i f (Event. SourceType == "MACRO' && Event. Action == "RUN")
{
var result = parselnt(Readlni ("MyVar","C\\test.ini"));
result += 2;
Noti fyEvent Str (" CAM', "1", " ANALOG PARAMS", "text<Vari able value = \n" + result + ">, Dblink_state<1>");


https://doc.axxonsoft.com/confluence/display/Int490en/Configuring+captions+display+on+a+video+image
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=84354171
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=84354171
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=84354171
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=84354171
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=124980307
https://doc.axxonsoft.com/confluence/display/Int411en/Attaching+objects+to+the+layers+of+interactive+map

DebuglLogString(result);

Example 4. Displaying camera on the monitor by clicking the button on the remote control

The following example is valid only for cameras in configuration of which there is PTZ control panel. When configuring Video surveillance monitor select the Go to preset action with
1,2,3...,0 parameters for ten joystick buttons (see Assigning commands to joystick buttons using the Monitor section of Installing and configuring security system components guide).

|1 IM s Coordinates GQuad zplitter
anitar :
. . W IEEI Y- |50 tdonitar: horizontk I
D'_S""” o wileo w1 o vertical: [
|D|$pla_l.J L j I~ Allow moving
Maouse Joystick
Behavior Action Param. | Butt. Ot P
Left button I{Default} j I_ 1 |Go to preset j 1
Right button I{DEfﬁLﬂt} j I_ 2 |Go to preset j E
. 3 |Go to preset j 3
Middle button | (Defaul) =l . Py ~
Scroling I{Default} j I_ 5 |Go to preset j |5_
shift +Scrolling | Default) | |_ g |Go to preset - |5_
Shift + Left [Defauit Wl 2 et |
8 |Go to preset j IS_
Shift + Right | (efauit) = | roepep— - ol
shift + Middle butt. [ (Defaul) =[] 10 [Go topreset = o

Bazic settingsl List of cameraz ~ PTZ I

Example. When the button is clicked on the control panel, display corresponding camera in the active monitor. The script is to timer trigger with ID=1.
Note.
The Timer object is to be created and configured beforehand and the current year is to be set. Information on how to configure the Timer object can be found in Creating and

configuring the Timer object section of Administrator's Guide

After each button click on the control panel wait for 2 seconds until clicking another button. If there is no button click, then the camera with dialed number is to be displayed.


https://doc.axxonsoft.com/confluence/display/Int411en/Assigning+commands+to+joystick+buttons+using+the+Monitor
https://doc.axxonsoft.com/confluence/display/Int411en/Installing+and+configuring+security+system+components+guide
https://doc.axxonsoft.com/confluence/display/Int411en/Creating+and+configuring+the+Timer+object
https://doc.axxonsoft.com/confluence/display/Int411en/Creating+and+configuring+the+Timer+object
https://doc.axxonsoft.com/confluence/pages/createpage.action?spaceKey=Int411en&title=Administrator%E2%80%99s+Guide&linkCreation=true&fromPageId=136250420
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if (Event. SourceType=="TI MER' && Event. Sourcel d=="1" && Event. Acti on=="TRI GGER')
{

mon="1";

DebuglLogString("on monitor "+ Itv_var("cant));

DoReact Str (" MONI TOR', non, " ACTI VATE_CAM', "canx" +l tv_var (" cant') +">");
Itv_var("cant)="";

}

i f (Event. GetParan{"source_type")=="TELEMETRY" && Event. Get Paran{"acti on")=="G0 PRESET")

{
DoReact Str (" TI MER", " 1", " START", "bound<2>");

var key=Event. Get Paran{"paramt_val");
DebuglLogStri ng(" Key: " +key) ;
Itv_var("cam')=Itv_var ("canl') +key;
DebugLogString(ltv_var("cani));

Example 5. Sending command to camera using the camera HTTPAPI

Example. Camera IP address is 192.168.0.13.

The command enables the camera wiper:

192. 168. 10. 101/ ht t papi / SendPTZ?act i on=sendpt z&PTZ_PRESETSET=85

The command disables the camera wiper:

192. 168. 10. 101/ ht t papi / SendPTZ?act i on=sendpt z&PTZ_PRESETSET=86

These commands are to be sent to camera using the Jscript script.

function DoPreset (preset)

{
xm htt p=new Acti veXQhj ect (" MSXM.2. XMLHTTP") ;
if(xmhttp == null)
{
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return;
}
xm http.open("GET", "http://192.168.0. 13/ htt papi/ SendPTZ?acti on=sendpt z&PTZ_PRESETSET="+preset, fal se,"
adm n","1234");

xm http. send();
DebuglLogSt ri ng(xm http. status);

?f (Event. Sour ceType == "MACRO' && Event. Sourceld == "6" && Event.Action == "RUN")
{DoPreset("85");

}

i f (Event. SourceType == "MACRO' && Event. Sourceld == "7" && Event.Action == "RUN')
{DoPr eset ("86");

}

Example 6. Script for framing abandoned objects in live video

If the object tracking function is in use (see Creating and configuring the Timer object section of Administrator's Guide), then detected objects will be framed in video when viewing the
archive. To frame abandoned objects in live video use the script aimed to frame an abandoned object when receiving alarm from VMDA detection tool:

i f (Event. SourceType=="CAM VMDA DETECTOR")
{
cam=Get bj ect Par ent | d(" CAM_ VMDA DETECTOR', Event. Sour cel d, " CAM') ;
if (Event.Action=="ALARM)
{
var x1,x2,yl,y2;
x1=Event. Get Paran{"x");
x2=Event . Get Paran{"w');
yl=Event. Get Paran("y");
y2=Event . Get Paran("h");
x2=par sel nt (x1) +par sel nt (x2) ;


https://doc.axxonsoft.com/confluence/display/Int411en/Creating+and+configuring+the+Timer+object
https://doc.axxonsoft.com/confluence/pages/createpage.action?spaceKey=Int411en&title=Administrator%E2%80%99s+Guide&linkCreation=true&fromPageId=136250420

y2=par sel nt (yl) +parselnt (y2);

DoReact Str("MONI TOR', "", " SET_MARKRECT", " canx" +camt" >, col or <255>, i d<" +camt" >, x1<" +x1+" >, x2<" +x2+" >, y1<" +y1+" >,
y2<ll +y2+ll >II ;
DebuglLogStri ng("x1:"+x1+" x2:"+x2+" y1l:"+yl+" y2:"+y2);
}
el se
{
DoReact Str("MONI TOR', "", " DEL_MARKRECT", " canx" +camt" >, i d<" +cam+" >") ;
}
}

Example 7. Using START and STOP events for Failove

Objects from more than one main Server are not to be moved to the Backup Server. For this when moving objects from some main Server to the Backup Server all other Failover
objects are to be disabled on this Backup Server.

if (Event. SourceType == "FAlILOVER' )

{
if (Event.Action == "START") {action="Dl SABLE";}
if (Event.Action == "STOP") {action="ENABLE";}

i d=Event . Sourcel d;
nmsg=Cr eat eMsg() ;
nsg. StringToMsg( Get Obj ect 1 ds(" FAI LOVER"));
var
obj Count =nsg. Get Paran("i d. count");

for (i=0;i<objCount;i++)

{

pi d=nsg. Get Paran("id. " +i);

it (1(id==pid)) {
DoReact St r (" FAI LOVER', pi d, action, "");
}
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Programming Guide (JScript). Conclusion

More detailed information on the Intellect software package is presented in the documents titled:

1. Installing and configuring security system components guide;
2. Operator’s Guide;
3. Administrator’s Guide.

If while operating the given software product you have faced difficulties and problems, you are welcome to contact us. However before addressing us, we kindly ask you to answer the
following questions:

1. What is the problem?
2. When did the problem occurr and what had happened before it occurred?
3. Which conditions gave rise to the problem?

Remember, that the more detailed and precise information you give us, the faster our experts will resolve your problem.
We are striving to improve the quality of our products, and hence welcome any proposals and suggestions how to improve our software and documentation.

Please forward your suggestions to the following e-mail addresses: documentation@axxonsoft.com

Appendix 1. Description of the Editor-Debugger utility
The purpose of the Editor-Debugger utility

The Editor-Debugger utility is designed for creating, debugging and editing scripts in the Intellect software package.
The Editor-Debugger utility provides the following functionality:

Creating and editing scripts using the built-in text editor;
Debugging scripts using the built-in debugger window;

Filtering the information to be displayed in the debugger window;
Creating and using test events for debugging;

Saving scripts to the hard drive;

Opening scripts from the hard drive.

ounhkwN =

The interface of the Editor-Debugger utility
The Editor-Debugger window

The Editor-Debugger window contains the main menu, the toolbar (1), the object list (2) and the viewing/editing panel (3).


https://doc.axxonsoft.com/confluence/display/Int490en/Installing+and+configuring+security+system+components+guide
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=86474942
https://doc.axxonsoft.com/confluence/pages/viewpage.action?pageId=84354171
mailto:documentation@itv.ru
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The Script Debug/Edit tab
Description of the Script Debug/Edit tab

The Script Debug/Edit tab is used for editing scripts and creating test events.

Figure shows the Script Debug/Edit panel.
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Table shows the description of the elements in the Script Debug/Edit panel.
N2 Field name Field Description Units Default Value
type value range

1  Settings message Auto  Script object Latin, Cyrillicand - -
initialization information special symbols
2  Additional information Auto Additional information Latin, Cyrillicand - -

about scripts special symbols

The Script object panel in the Script Debug/Edit tab

The Script objects in the Script Debug/Edit tab are used for creating and editing scripts and test events.

Figure shows the Script object panel.
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Table describes the elements in the Script object.

N2 Field Field type Description Units Defaul
name :
value
1  Script Text field The text Latin, Cyrillicand Empty
of the script special symbols
2 Event Text field Event description Latin, Cyrillic and Empty

in the line format special symbols

The Script Messages tab
Description of the Script Messages tab

Value

range

Unlimited number
of characters
Unlimited number

of characters




The Script Messages tab is used to display the debugger windows for the scripts.

Figure shows the Script Messages panel.
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Table shows the description of the elements in the Script Messages panel.
Ne¢ Field name Fiel Description Units Defaul Value
d t
range
type value
1  Settings message Auto  Script object initialization Latin, Cyrillic and -

information special symbols

2  Additional information Auto Additional information Latin, Cyrillicand - -

about scripts special symbols



The Script object panel in the Script Messages tab

The Script panels in the Script Messages tab are used to display system, test and user events related to the scripts created in Intellect.

Figure shows the Script object panel.
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Table describes the elements in the Script object.

NS Eield Na Fiel Description Units Default Value
d
me value range
type

1  Description Auto Information about the Latin, Cyrillic  Unspecifi By default 200 lines are displayed in the list. The value can be changed using the DebugMaxLines registry key (see Registry
events and ed keys reference guide).

occurring in the system  special
symbols


https://doc.axxonsoft.com/confluence/display/Int490en/Registry+keys+reference+guide
https://doc.axxonsoft.com/confluence/display/Int490en/Registry+keys+reference+guide
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Main menu

On the page:

Description of the main menu

The elements in the File menu

The elements in the View menu

The elements of the Debug and edit menu
The Message list menu elements

Description of the main menu

The Editor-Debugger main menu is used to call editing, debugging and

list and Help.

Table describes the elements of the main menu.

N2 Element name

1 File

2  View

3  Debug and Edit

4  Message list

5 Help

Element

type

Drop-down

list of items

Drop-down

list of items

Drop-down
list of items
Drop-down

list of items

Drop-down

list of items

Description

Commands for opening

and saving scripts and
closing the utility

Commands for displaying the
toolbar and the status

bar in the utility window
Commands for script
debugging

Commands for changing

the message display parameters
in the debugger windows
The About command showing
general information about

the Editor-Debugger utility.

Units

other commands. The commands are grouped into functional menus: File, View, Debug and edit, Message

Defaul Value
t
range
value



The elements in the File menu
The File menu is used to open and save scripts and to close the utility.

Table describes the elements of the File menu.

No. Element Element Description Units Defaul Value
t
name type range
value
1 Save to database Item Saves the script - - -

in the object
2 Save to disk Item Saves the script into

a text file on the hard drive
3 Open from disk Item Opens the script file - - -
4 Exit Item Shuts down the utility - - -

and closes the window

The elements in the View menu
The View menu contains commands for showing and hiding the toolbar and the status bar.

Table describes the elements of the View menu.

N2 Element Element Description Units Default Value
name type value range
1 Toolbar Checkbox Shows or hides Boolean Checked Check - show toolbar
the toolbar Uncheck - hide toolbar

2  Status bar Checkbox Shows or hides Boolean Checked Check - show status bar

the status bar Uncheck - hide status bar

The elements of the Debug and edit menu
The Debug and edit menu contains the commands for debugging scripts.

Table describes the elements of the Debug and edit menu.

N2 Element Element Description Units Defaul Value
t
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name type range

value
1 Testrun Item Runs the script with the test event - - -
2 Testrun Item Runs the script using the - - -
in third- third-party debugger
party
debugger
3  Edit test event Item Opens the window for editing test events - - -
4  Summary Item Opens the Thread Information - - -
information window showing system, test and user

messages related to the current script
5 Gotoline Item Opens the window for entering the script = - - -

line and character number to go to

The Message list menu elements

The Message list menu contains commands for changing the message display parameters in the debugger window.

Table describes the elements of the Message list menu.

N2 Element Element Description Units Defaul Value
t
name type range
value
1 Clear Item Clears the Description field - -

in the debugger window
2 Colors Item Opens the window allowing to - - -
specify the words that a line should
contain to be highlighted in color
3 Search Ttem Searches for a word in the Description Window - - -
4 Set filter Item Opens the window allowing to set the filtering - - -
criteria for the messages in the debugger window.

5  Apply filter Item Applies the current filter - - -
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The Filter dialog window
The Filter window allows to set the filtering criteria for the messages displayed in the Description field of the debugger window.

To open the Filter window, do one of the following:

1. Click the Edit test message ( b ) button in the Editor-Debugger toolbar.
2. In the Debug and edit menu, select Edit test message.

Figure shows the Filter window.
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Table describes the elements in the Filter window.

N2 Element Element Description Units Defaul Value
t
name type range
value
1 Include Text field Only the lines containing the Latin, Cyrillicand Empty Unlimited number
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words from this field will be special symbols of characters

displayed in the debugger window

2  Exclude Text field The lines containing the words from Latin, Cyrillic and Empty Unlimited number

this field will not be displayed special symbols of characters

in the debugger window

The Color dialog window
The Color dialog window is used for setting up color highlighting of the lines containing certain words.
To open the Color window, do one of the following:

1. Click the Colors ( ni ) button in the Editor-Debugger toolbar.

2. In the Message list menu, select Colors.

Figure shows the Color window.
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Table describes the elements in the Color window.

N2 Element Element Description Units Defaul Value
name type ‘ range
value
1 Words Text field Contains the words or any sequences Latin, Cyrillic Empty  Unlimited number
of characters, that make the line and special symbols of characters

containing one of them, highlighted.
2 Color Drop-down The color for highlighting the lines RGB format Grey RGB colors

list

The toolbar of the Editor-Debugger utility
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The Editor-Debugger toolbar is used for calling frequently used functions of the utility.

The toolbar operates in two modes: when the script control buttons are active, or when the debugger window control buttons are active.

The mode depends on the currently active tab of the Editor-Debugger utility: either the Script Debug/Edit tab for editing scripts, or the Script Messages tab for viewing messages
in the debugger window.

Figure shows the toolbar in the script editing mode.
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Table shows the elements of the toolbar in the script editing mode.
Neo Element Element Description Units Defaul Value
t
name type range
value
1 Testrun Button

Runs the script with the test event

2  Test run in third-party Button Runs the script using the third-party debugger
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debugger
3 Save Button Saves the script to the Script object - -
4  Edit test event Button Opens the window for editing test events - -
5 Summary information Button Opens the Thread Information window that displays - -
system, test and user messages related

to the current script

Figure shows the toolbar in the script debugging mode.
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i Expected identifier0 O Src: Microsoft J5cript compilation error 0 OLine:2 Char:6 Ervor:0 Scode:§002
- Script 2 End ProcessScript, begin-end delay: 2 [msec]
i e Seript 3 Process Event:Cam |1 |MD_STOR|int_obj_id<1>,slave_id<E-R¥AZAMOYA =,core_global <1 =, owner <
EI Script Debug/Edit Expected identilfierEI I:I_Src: Microsoft 15cript compilation error 0 OLine: 2 Charié Error:0 Scode: 8002
: Geript 1 End ProcessScript, begin-end delay: 1 [msec]

b Process Event:ZAM|1|MD_START|int_obj_id<1>,slave_id<E-RYAZANOYA =, core_global <1 =, 0mner
- Seript 2 Expected identifier 0 OSre: Microsoft 1Script compilation error 0 OlLine:2 Chari6 Errori0 Scode: 8002
- Srpt 3 End ProcessScript, begin-end delay: 0 [msec]
Process Event:ZAM |1 |MD_STOP|int_obj_id<1=,slave_id<E-R¥AZAMOYA =, core_global <1 =, owner =
Expected identifier OO Src: Microsoft JScript compilation error 0 OLine: 2 Char:6 Error:0 Scode: 8002
End ProcessScript, begin-end delay: 1 [msec]
Process Event:CAM |1 |MD_START|int_obj_id<1>,slave_jd<E-RYAZANOYA =, core_global<1 =, 0mner
Expected identifier OO 5rc: Microsoft J5cript compilation error O OLine: 2 Char:6 Error:0 Scode: 8002
End ProcessScript, begin-end delay: 0 [msec]
Process Event:CAM |1 |MD_STOR|int_obj_id=1=,slave_id<E-RYAZAMOYA =, core_global<1 =, owner =
Expected identifier OO 5rc: Microsoft J5cript compilation error 0 OLine: 2 Char:6 Error:0 Scode: 8002
End ProcessScript, begin-end delay: 1 [msac]
Process Event:SCRIPT|1|SETUP|ink_obj_id<1>,5LAYE slave_id,count <0, flags <>, parent_id< =,k
Expected identifier OO 5rc: Microsoft J5cript compilation error 0 OLine: 2 Char:6 Error:0 Scode: 8002
End ProcessScript, beqgin-end delay: 1 [msec]
Process Event:CaM|1|MD_START|int_obj_id=1>,slave_id<E-RYAZANOYA >, core_global <1 =,0mner
Expected identifier 0O 5rc: Microsoft J5cript compilation error 0 OLine: 2 Char:6 Error:0 Scode: 8002
End ProcessScript, begin-end delay: 3 [msec]
Process Event:CaM |1 |MD_STOP|int_obj_id<1=,slave_id<E-R¥AZANOYA =, core_global <1 =, owner =
Expected identifier OO 5rc; Microsoft J5cript compilation error 0 OLine; 2 Char:6 Error;0 Scode; 8002
End ProcessScript, begin-end delay: 1 [msec]
Process Event:CAM|1|MD_START(int_obi_id<1=,slave_id<E-RYAZANOYA =, care_global<1 =,0wner
Expected identifier OO 3rc: Microsoft JScript compilation error 0 OLine: 2 Char:6 Error:0 Scode: 5002

4| | »
[ o [

Table shows elements of the toolbar in the script debugging mode.

N2 Element Element Description Units Defaul Value
t

name type range
value
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1 Clear Button Clears the Description field in the debugger window - -

2  Colors Button Opens the window allowing to specify the words that - - -
a line should contain to be highlighted in color

3  Search Button Searches for a word in the Description window - - -

4  Set filter Button Opens the window allowing to set the filtering criteria - - -
for the messages in the debugger window.

5 Apply filter Button Applies the current filter - - -

Appendix 2. Creating virtual objects with ability to set events,
reactions and states
Purpose of virtual objects and their implementation in Intellect

Virtual objects represent software emulation of new Intellect objects and allow configuring their states, reactions and events. Virtual objects are handled using scripts, macrocommands
and macroevents.

Virtual objects are created using the ddi.exe and CustomTypeEditor.exe utilities in the <Intellect installation folder>\Tools.

In the How to create a virtual object section you can find an example of creating 2 types of virtual objects that can be used to show the state of abandoned object detection tool on the
map or to show any other user states. The states of objects are changed using macros, scripts or via IIDK.

How to create a virtual object

Here one can find out how to create the following virtual objects:

1. CUSTOM type with SLAVE (Computer) parent type.
2. CUSTOM_CHILD type with CUSTOM parent type (see item 1).

An object of the CUSTOM type has the property set:

Custom_param1 and custom_param2 parameters
Events: ALARM, INFO, ON, OFF
Reactions: ON, OFF
States: ON, OFF
State machine:
1. Set ON state for ON event
2. Set OFF state for OFF event

nhwnNe

The CUSTOM_CHILD type of the object is created to demonstrate tree structure and has no user parameters, events, reactions or states.

dbi file preparation
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A dbi file is prepared using the ddi.exe utility. Details on how to handle it can be found in the The ddi.exe utility for editing database templates and external settings files section of Adm
inistrator's Guide.

A dbi file for objects of CUSTOM and CUSTOM_CHILD type is created as follows:

1. Run dbi.exe (see The ddi.exe utility for editing database templates and external settings files).
2. Go to the DBI tab.
3. Create two objects - OBJ_CUSTOM and OBJ_CUSTOM_CHILD - as shown in the figure below.

Important!

Object (table) names should look like OBJ_<object type>.

Sooranmeior =
File
‘DDI DBI | Field name Type Size Description
QBJ CUSTOM id CHAR T |16
OBJ_CUSTOM_CHILD S— CHAR P
parent_id CHAR - |16
flags INTEGER -
quid UNIGUEIDENTI... =
custom_param1 TEXT -
custom_param2 INTEGER &

[OBJ_CUSTOM]

id, CHAR, 16

name, CHAR, 60
parent_id, CHAR, 16

flags, INTEGER

guid, UNIGUEIDENTIFIER
custom_param1, TEXT
custom_param2, INTEGER

Total objects: 2

Note.

Id, name, parent_id, flags and guid parameters are mandatory for all objects. Custom_param1 and custom_param2 are user parameters.

4. Save changes using the Save command in the File menu. The saved file must have dbi extension and must be located in Intellect installation directory - C:\Program Files (x86)
\Intellect\intellect.custom.dbi

dbi file preparation is complete.

ddi file preparation
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A ddi file is prepared using the ddi.exe utility. Details on how to handle it can be found in the The ddi.exe utility for editing database templates and external settings files section of Ad
ministrator's Guide.

A ddi file for CUSTOM and CUSTOM_CHILD object types is created as follows:

1. Run ddi.exe (see The ddi.exe utility for editing database templates and external settings files).
2. Create CUSTOM and CUSTOM_CHILD objects in the DDI tab as shown below.
: DDI & DBI Editor * s P [m] 5|

File

Names | E\rentsl Reactions | lcons | Statesl Transfer nles I

Search by name
Object | Name | Group name
» CUSTOM
CUSTOM_CHILD Child wirtual object

Total objects: 2
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3. Go to the Events tab and configure events that are to be supported by the object (see the figure).

- DDI & DBI Editor * B =10l %
File
Dol IDBI I "Mames Everts IReactlons | lcons I States | Transfer nles I
CUSTOM Disable ;.
_— Processing Disable
CUSTOM_CHILD Mame Description P Audio support gngion loaging Windows log

] H = [ [ u

Evertifo | INFORM... [ [ ] ] ]

e Enabled - =] r O O

OFF Disabled < O - O O

rE o r r r r
| Parameter | Name | Type Element | Value

Total objects: 2

4. Go to the Reactions tab and configure reactions that are to be supported by the object (see the figure).

Note.

Reactions of virtual objects are automatically converted into events. In other words, a virtual object automatically generates an event when there is a reaction.
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> DDI & DBI Editor * i =10l x|

File

ool IDEI | "Names | Everts FReactions | leons | States | Transfernles |

CUS Reaction Description Arming jion

CUSTOM_CHILD oN Enab|sph 4= I
#|OFF Disable r
* r

| Parameter | Name | Type | Element | Valus

* | | | :

Total objects: 2

5. Go to the States tab and describe the states that the object can take. Here there are two states - ON and OFF.

Comaomramr- e ioix]
File
DoI IDEI | " Names | Everts | Reactions | lcons  States ITransferru\eal
CLS Name Image Description Blinking on alamm
CUSTOM_CHILD on on Enabled r
OFF off Disabled r

- — r

Total objects: 2

Note.
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The postfix of file name is specified in the Image column - the image that is stored in < Intellect installation directory>\Bmp. For instance, these will be custom_ off.
bmp and custom_on.bmp files (corresponding to ON and OFF states) for CUSTOM object. These files will be used by the map module.

6. Go to the Transition rules tab and set the object state change logic.

¥ DDI & DBI Editor *

i o ] 54
File
ool IDBI I "Names. Eventsl Reac!.iunsl lcons I States  Transfer nles |
CUSTOM Event | Move from state Move to state
CUSTOM_CHILD » on =

4

oN -
- |OFF -

OFF

Total objects: 2

Transition rules is a simple state machine - an event is an input action and a state is a result.

An unconditional transition is used in this case: if CUSTOM||ON event is received, then there is transition to the ON state, if CUSTOM||OFF event is received, then there is
transition to the OFF state.

7.

To save changes use the Save command in the File menu. The saved file must have the ddi extension and be stored in the folder corresponding to the required language, e.g.
C:\Program Files (x86)\Intellect\Languages\en\intellect.custom.ddi

The ddi file preparation is completed.

XML file preparation

An XML file is prepared using the CustomTypeEditor.exe utility that can be found in <Intellect installation directory>\Tools. The utility overview is shown below.

=

File

object_type | parent_type | has_child
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An XML file for a virtual object is created as follows:

1. Specify the name of object type in the object_type field (1).

== X

File

object_type parent_type has_child
CUSTOM SLAVE v

CUSTOM_CHILD JCUSTOM

Specify the name of parent type in the parent_type field (2).

If the object type has child types, then set the has_child checkbox checked (3).

Repeat steps 1-3 for all object types.

Save a file with any name in the Intellect installation directory using the File - Save command.

aua b wnN

The XML file is now created. The file contents look like this:
<?xm version="1.0" standal one="yes" ?>
<obj ect s>

<obj ect >

<obj ect _t ype>CUSTQOWK/ obj ect _t ype>

<par ent _t ype>SLAVE</ parent _type>
<has_chi | d>1</ has_chi | d>

</ obj ect >

<obj ect >

<obj ect _t ype>CUSTOM CHI LD</ obj ect _t ype>
<par ent _t ype>CUSTOWK/ par ent _t ype>

</ obj ect >

</ obj ect s>

Modify it manually if required.
Creating and using a virtual object in Intellect

On the page:

® Showing on the map
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® Using in macros
® Sample program in Jscript to change virtual
object state

When dbi, ddi and XML files are ready objects of a new type along with standard objects can be created in Intellect hardware tree.

Hardware Programming

Alarm Message Window
Archive
ATM

Audio card

|’ Change parameter...

Expand tree

Collapse tree Data replication service

Event counter

Camera discovery tool

*

External storage

Failower
IIDK Interface

Delete object

Create folder... Intercom Subsystem

Keyboard
LDAP service

Long-term archive

e [ HEE @R

Save
Find...

=
=

Send to all Long-term audio archive

Load configuration. .. Mail Message Service
Operator guery pane
PAMEL

Playback card

PS-RTP Server

risp Server

RUBEG

Short Message Service
SNMP Objects

Sound notification

Save configuration...

L <o Ve ko

System restart service

JCFE L= DD RDENME

(&

Telemetry Controller
Video capture device
Videogate

Virtual object

VMDA metadata storage

Voice Message Service

Voice notification service
Web-server
Web server 2.0

O & & &4 nfee w

Computer

User parameters are displayed on the settings panel of the created virtual object — custom_param1 and custom_param?2 in this example. Their values can be set in the table.
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Architecture Hardware ntefaces Programming

custom_param|

=I5 LOCALHOST [S-UYUTOVA]
T device 1[1] i [Virtual obiect 1 e
[ Jvrtua bject 1 (1] Conputer I Disable
LOCALHOST =

Cancel

Showing on the map

When an object is created in the hardware tree it can be placed on the map and set reactions can be executed in the object context menu (see Configuring the interactive map for
object state indication and controlling the objects).

Virtual ohject 1[1]

Enahle
Disable

Using in macros

When a virtual object is created in the hardware tree it can be used in macros.
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2 Macro 2
[~ Disable
 Settingsz
State | - ™ Local I” Hidden
Events Farameters
Type | Mu... | M amne | Ewent I arne | W alue |
tacro 1 Macro 1 Action executed
1] | 2]
Actiohs Parameters
Type | M. | Mame | Action Marne | Walue
Yirtual object 1 Wirtual object 1 Enable
Kl | 2l

Apphy Cancel

Note.
Reactions of virtual objects are automatically converted into events. Thus, in the sample when ON reaction is executed the object state changes thanks to set state transition

rules (see ddi file preparation) and the icon corresponding to the state will be shown on the map.

Sample program in Jscript to change virtual object state
Problem. Using macro 1 change a state of virtual object 1 to ON and show the icon corresponding to this state on the map.

Solution. As state transition rules are set, when ON event is sent from the virtual object the state will be automatically changed to ON and the icon specified in ddi file (see ddi file
preparation) to this state will be shown on the map. A script for sending ON event looks like this:

if (Event. SourceType == "MACRO' && Event. Sourceld == "1" && Event. Action == "RUN")
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var nmsgevent = CreateMsg();
nsgevent . Sour ceType = "CUSTOM';
nsgevent. Sourceld = "1";
nsgevent . Acti on = "ON'

Not i f yEvent (nmsgevent);
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